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Design Considerations: Speeding Up High-Fanout Nets 

This section describes several techniques for speeding up the performance of 
designs created by the Warp system's SpDE tools. For more information, refer to 
Chapter 9, "Synthesis." 

For high-fanout, timing-critical nets, designers should consider improving design 
performance using buffering techniques. In some cases, solutions such as 
paralleling or pipelining can be used. 

Five techniques that can be used to improve circuit performance are described on 
the following pages: 

• double buffering 

• split buffering 

• selecti ve buffering 

• paralleling 

• pipelining 

Double Buffering 

The pASIC architecture allows two sources to drive a net in specific cases. This is 
called double buffering. Using two gates to drive a high-fanout net speeds up the 
performance of the net dramatically. 

Figure 5-26 is an example of double buffering in a schematic. 
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IN1r-------~~~ 

IN2 >----~...._t_+_--'":~ KULTI-BUFIl'E:R 
=TRUE 

INV 

INV 

Figure 5-26 Double buffering example 

SpDE 

OUT 0 

OUT1 

OUT 2 

OUT 3 

OUT4 

OUTS 

OUT' 

OUT 7 

Double buffering is legal as long as the two gates driving the high-fanout net are 
identical gates, with the same nets on the inputs and output. Each gate must fit 
into an AND-fragment (P Afrag_a library element). Double buffering is an 
excellent performance solution, and offers the best skew and delay characteristics 
of all buffering solutions for fanouts of 8 to 16. An example of double buffering in 
a VHDL source file is the following: 

Resolution function for wired-or. Used to create 
-- legal VBDL for double-buffering techniques 
-- employed for pasic. 

use work.resolutionpkg.all; 
use work.GATESPKG.all; 
use work.cypress.all; 
use work.rtlpkg.all; 

Warp User's Guide 243 



SpDE 

244 

entity DOUBLEBUF is 
port (INO: IN bit; 

IN1: IN bit; 
IN2: IN bit; 

OUT7: I NOUT bit; 
OUT6: INOUT bit; 
OUTS: INOUT bit; 
OUT4: INOUT bit; 
OUT3: I NOUT bit; 
OUT2: I NOUT bit; 
OUT1: I NOUT bit; 
OUTO: INOUT bit); 

end DOUBLEBOF; 

architecture archDOUBLEBUF of DOUBLEBUF is 
-- net to be resolved 
signal multiple_driver: multi_buffer bit; 

begin 
multiple_driver <= INO AND INl AND IN2; 
multiple_driver <= INO AND INl AND IN2; 
OUTO <= NOT multiple_driver; 
OUTl <= NOT multiple_driver; 
OUT2 <= NOT multiple_driver; 
OUT3 <= NOT multiple_driver; 
OUT4 <= NOT multiple_driver; 
OUTS <= NOT multiple_driver; 
OUT6 <= NOT multiple_driver; 
OUT7 <= NOT multiple_driver; 

end archDOUBLEBUF; 

driver #1 
driver #2 

~----------------
Note - Double buffering on an 8x12 (1000 usable gates) or 12x16 
(2000 usable gates) device requires the use of express wires. 
These devices have limited express wire resources, so only a few 
double buffers should be used. Refer to the Section 5.4.4, 
"Router," for more information. 
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5.6.2 Split Buffering 

Split buffering breaks a wide-fanout net into two or more nets. 

Figure 5-27 is an example of split buffering. Without the buffers, the DFF drives a 
fanout of 8. As configured in the illustration, the DFF drives a fanout of 2, and 
each buffer drives a fanout of 4. 

... 
DI.ITO 

DI.IT1 

DI.ITl: 

IN ... 
..-. 

DI.I HI 

DFF 

t:u: D II 

01.1 YoI. 

IN ... 

DI.ITri 

OI.lTS 
F 

DI.IT7 
-' 

Figure 5-27 Circuit demonstrating split buffering 

~----------------
Note - Adding buffers introduces a logic cell delay to the net. 
This added delay must be balanced against the gain in reducing 
the fanout. Simple split buffering (as demonstrated in Figure 5-
27) is generally employed only with fanouts of 16 or greater. 
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Selective Buffering 

Selective buffering is the selective use of buffers in situations where a high-fanout 
net has a small number of critical destinations and a large number of less-critical 
ones. 

Figure 5-28 is an example of selective buffering. The DFF drives a fanout of 8, but 
only one of the destinations is in the critical path of the circuit. Inserting a single 
buffer between the DFF output and the 7 non-critical destinations restructures the 
circuit, so that the DFF drives a fanout of two without adding any logic cell delay 
in the critical path. 

IN ... 

[lUT[I 

... 
[lUTi 

[lUTZ 

[lUT~ 

OF'F' 

c u: F [I II 

[lUfoI. 

IN ... 

[lUU 

[I U TIi 
F 

[lI.IT 7 

Figure 5-28 Circuit demonstrating selective buffering 
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~ 
Hint - Buffers should be introduced with care and skill. Selective 
buffering offers tremendous improvement in circumstances 
where the circuit has a few dearly identifiable critical paths. 

Paralleling 

SpDE 

Paralleling is a design technique that duplicates the logic driving a high-fanout 
load to reduce the effective fanout. Duplicating the logic avoids the delay 
introduced by adding buffers to the circuit. 

Successful buffering must balance reduced fanout against the additional delay 
that use of buffers causes. Paralleling is an alternative that does not introduce this 
added delay. 

aUTO 

aUT:l 

NY 

au Till! 

NY 

IN 0 
OUT] 

IN:l 
NY 

IU no] 

OUT .II 

NY 

OUTS 

dUTS 

dun 
NY 

Figure 5-29 Circuit demonstrating paralleling 
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Figure 5-29 is an example of paralleling. The AND gate has been duplicated, with 
each of its inputs tied to the corresponding input on the "twin" gate. Each AND 
gate drives a fanout of 8, effectively halving the fanout, without introducing the 
added delay associated with buffering. By duplicating the AND gate, however, 
the fanout on each of the input nets has been increased. 

Paralleling is similar to double buffering, except that the outputs are not tied 
together. Paralleling should be used instead of double buffering when: 

• skew is not critical 

• too many express wires have already been used for high-drive inputs or 
double buffers (see the section on the Router) 

• the logic to be replicated does not fit into an AND fragment of the larger 
cell (no larger than a P Afrag_a library element) 

Pipelining 

Pipelining is the technique of inserting registers in long combinatorial paths, 
effectively increasing the system clock rate. 

Inserting registers in long combinatorial paths shortens the length of the critical 
path and allows operations to be overlapped, increasing the system clock rate. 
The pASIC architecture promotes pipelining, as each logic cell contains a D flip
flop. As a result, a design can be pipelined with little or no increase in the number 
of logic cells used. 

For more information on achieving high performance or high utilization in 
designs, see Chapter 9, "Synthesis." 
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6.1 Introduction 

Nova is Cypress Semiconductor Corporation's name for its JEDEC-based 
functional simulator. 

The Nova user interface provides an easy way to: 

• specify JEDEC files to simulate 

• read or write stimulus files 

• convert files from .jed to ViewSim format 

• edit input waveform traces 

• simulate the behavior of a design 

• alternate between various views (i.e., collections of signals) and specify 
signals to be included in each view 

• specify the length and resolution of a simulation 

• specify segments, where initial conditions can be reapplied and edited in 
order to compare results of differing initial conditions side-by-side 

• other useful capabilities 

This manual describes how to use Nova to simulate designs. It assumes 
familiarity with common user interface operations for the computer, such as the 
use of scroll bars, menu buttons, and opening and closing windows. 

Advanced users may refer to Section 6.9, "Nova JEDEC Simulator Quick 
Reference Sheet," for a brief overview of the major functionality. 

6.2 Starting Nova 

250 

On Sun workstations, typing nova on the command line brings up the Nova 
window. On PCs and compatibles, double-clicking on the Nova icon in the 
Cypress group window brings up the Nova window. 

By default, Nova comes up ready to run on a color screen. 

To start Nova on a monochrome Sun workstation, type nova -m on the 
command line. 
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To set Nova to come up in monochrome mode when running Windows on an 
IBM PC or compatible computer, do the following: 

• Select the Nova icon from the Warp R4 group window. 

• Select Properties from the File menu. 

• Edit the Command Line entry to include the -m option. 

• Click OK. 

The Nova Window 

The Nova window (Figure 6-1) consists of a menu bar with several items across 
the top; a column of buttons along the left side, listing pin and node numbers and 
signal names; an area for displaying traces; and scroll bars across the bottom and 
right sides. 

Menu Bar 

The menu items are File, Edit, Simulate, Views, and Options. Under each of these 
items are menus for selecting related actions. The menus are ordered so that the 
most common operation is at the top. The contents of each menu are described in 
greater detail later in this chapter. 

Only two menu items, Open and Exit, are enabled in the File menu when Nova 
first opens. When the user opens a .jed file, the other menu items will be enabled. 

Node Numbers, Signal Names 

The left-hand side of the Nova window consists of a column of bu ttons, 
displaying pin and node numbers and their associated signal names. A node is an 
area of a circuit containing one or more points whose locations the user may wish 
to trace. (For information about different values within a node, refer to 
Section 6.5.4, "Nodes.") 

To change the width of the buttons where signal names are displayed, use the 
Signal Name Size item in the Options menu. 
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Trace Area 
The trace area displays the values of the nodes/ signals listed in the left-hand 
column. 

Figure 6-1 Main Nova Window 

The window displays up to two measuring cursors, which allows the user to see 
precisely the value(s) of several signals at a single time. To display the first cursor, 
click at the bottom of the trace window. To display a second cursor, click at the 
bottom of the trace window while pressing the Shift key. 

To change the position of either cursor, click and hold on the cursor at the bottom 
of the trace window, then drag the cursor to its new position. The cursor's 
horizontal position in simulation tics is displayed next to each cursor. 

Note that a simulation tic does not represent any set amount of real-time delay. 
Instead, a simulation tic is simply a unit of simulation time. 

6.4 The File Men u 

252 

The File Menu contains items related to opening JEDEC files for simulation, 
reading and writing stimulus files, and saving output files in various formats. 

The File menu (Figure 6-2) in the Nova dialog box contains the following items: 

• Open ... 

• Write Sim·(*.sim) 

• Write Trace (*.psd) 

• Read Stimulus File 
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• Write JEDEC Vectors 

• Write JEDEC File (*.jed) 

• Disassemble to ViewSim Format (*.vhd) 

• Exit 

• About ... 

The operations of each of these menu items are discussed in greater detail on the 
next few pages. 

Write JEDEC Vectors 
Write JEDEC File (*.jed) 
Disassemble to ViewSim format (*.vhd) 

E~it 

8bout... 

Figure 6-2 Nova File Menu 

Opening Files 

The Open ... item in the File menu selects which .jed file to open and tells Nova 
what device is targeted in simulation. 

Selecting Open ... brings up the Open Files dialog box (Figure 6-3). The File Name 
line specifies the names of files to view or to open in the Files window. By default, 
this line reads I/*.jed." 
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To open a file, the user can select a file from the list shown in the Files window, or 
type the name of the file on the File name line. Selecting a .jed file and clicking on 
Open closes the dialog box and, displays traces. (If a stimulus file of the form 
filename.sim orfilename.stm exists, it is also read automatically.) Clicking on Cancel 
closes the dialog box without opening a file. 

The Select Device dialog box (Figure 6-4) comes up when the user clicks on Open in 
the Open Files dialog box, and the file to be opened is a .jed file not created by 
Warp. The Select Device dialog box maps a JEDEC file to a device. 

Selecting a device with the wrong number of fuses brings up a message box 
stating: "Wrong device type for this JEDEC - QF doesn't match." This indicates 
that the number of fuses in the selected device does not match the number in the 
JEDEC file. 

~-----------------
Note - If Nova says that it cannot find file devices.dat,-check to 
make sure that the CYPRESS_DIR environment variable is set 
correctly. Nova uses this file to find the proper pin names and 
numbers for each target device and package. 

list Files of lJ'pe: 

II r".:' 

c:\w2tutor 

IC.7c:\ 
I!t w2tutor 
L:J Ic371 
L:J sch 
LJ S}lm 

LJ wir 
LJ work 

Driyes: 

IIiiii c: warp system II 

Figure 6-3 Open Files Dialog Box 
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C16L8 
C16R4 
C16R6 
C16R8 
C20V8 
C16V8 
C20G10 
C20RA10 
C22V10 
C22VP10 
C33l 
C335 
C346 

Figure 6-4 Select Device 
Dialog Box 

Reading and Writing Stimulus Files 

Nova 

Write Sim and Write Trace save simulation data. Read Stimulus File reads data 
stored by a previous Write Sim operation. 

Write Sim saves the current simulation data to filename.sim, where filename is the 
prefix of the file the user is simulating. If a .sim file already exists with this 
filename, the new simulation data overwrites the old. The .sim file (see Figure 6-5) 
can be re-read with the Read Stimulus File option. 

Write Trace saves the trace information to filename. psd, where filename is the prefix 
of the file being simulated. The .psd file (see Figure 6-6) provides a column
oriented, human-readable record of trace values during the simulation. Bus 
values are not written to the file. 
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Read Stimulus File reads simulation data from a .sim file. Because reading in the 
simulation file may change some of the settings the user has set for the current 
simulation, a message box is displayed, asking if the stimulus file should be read 
in. A Yes reply reads in the .sim file. A No reply returns the user to the main Nova 
window. The filename.sim file is automatic all y read when the filename.jed file is 
opened. 

1 
e1 oelepi n1 
F83EOF83EOF83EOF83EOF83EOF83EOF83EOF83EOF83EOF83EOF83EOF83EOF83E 
0000000000000000000000000000000000000000000000000000000000000000 
000 0 000 0 000 0 0 000 
000 0 0 0 0 0 0 0 0 0 0 000 
000 0 0 0 0 0 0 0 0 0 0 000 
9999 
2 
pin2 
0000000000000000000000000000000000000000000000000000000000000000 
0000000000000000000000000000000000000000000000000000000000000000 
000 0 0 0 0 000 0 0 0 000 
000 0 000 0 0 0 0 0 0 000 
000 0 000 0 0 0 0 0 0 000 
9999 
3 
nieke1_pin3 
00FF800000000000000000000000000000000000000000000000000000000000 
0000000000000000000000000000000000000000000000000000000000000000 
000 0 000 0 0 0 0 0 000 0 
000 0 000 0 000 0 0 000 
000 0 0 0 0 0 0 0 0 0 0 000 
9999 

Figure 6-5 Portion of .sim File 
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000 0 L L L 
1 OOOLLL 
200 0 L L L 
3 000 L L L 
4 1 000 L L L 
5 000 0 L L L 
60000 L L L 
70000 L L L 
80100LLL 
90100LLL 

10 1 1 0 0 L L L 
11 1 1 0 0 L L L 
12 1 1 0 0 L L L 
13 1 1 0 0 L L L 
14 1 1 0 0 L L L 
15 0 1 0 0 L L L 
16 0 1 0 0 L L L 
17 0 0 1 0 L L L 
18 0 0 1 0 L L L 
19 0 0 1 0 L L L 
20 1 0 1 0 L L L 
21 1 0 1 0 L L L 
22 1 0 1 0 L L L 
23 1 0 1 0 L L L 
24 1 0 1 0 L L L 
25 0 0 1 0 L L L 

Figure 6-6 Portion 
of .psd File 

Writing JEDEC Vectors 

Nova 

Write lEVEC Vectors appends vector information to the JEDEC file. The vectors 
can be used to test parts after they are programmed. If the JEDEC file already 
contains vector information, the new vector information overwrites the old. 

Converting Between File Formats 

The File menu includes items that allow the user to convert vector information 
into different file formats, depending on what he wants to do with it. 

Figure 6-7 shows the various file types that can be input to or output from Warp, 
Nova, or a device programmer. 

Write lEVEC File (*.jed) writes out a JEDEC file from the data available to the 
simulator. The dialog box options include instructions in the JEDEC file to blow 
the security fuse when the device is programmed, or to write the JEDEC file using 
a compressed "K-field" hexadecimal representation. 
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Disassemble to ViewSim format (*. vhd) writes out a Viewlogic VHDL file which is 
used to simulate the design in ViewSim. The file is created in the vhd. 
subdirectory 

WARP 

DEVICE 

PROGRAMMER 

NOVA 

Figure 6-7 Possible Data Paths and File Formats 
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6.4.5 About and Exit 

The File menu's About item displays some basic information about the Nova 
simulator. The Exit item exits the simulator. 

Nova 

Besides displaying version information about the Nova simulator, the About 
dialog box also includes a Help button. Clicking on Help brings up help about 
Nova. 

6.5 The Edit Menu 

Use the items in the Edit Menu to modify trace information displayed on the 
screen. With the Edit menu, the user can set the selected range of a trace; create 
and delete view nodes; create, delete and edit buses; and change the bus radix. 

Items in the Edit Menu (Figure 6-8) include the following: 

• High, Low sets the selected trace or portion of a trace to lor 0, 
respectively. 

• Clock sets up repetitive pulses. 

• Pulse sets up a single pulse. 

• Node Defaults specifies the default source for the displayed value of a 
node. 

• Create View Node creates a new trace and selects the point within a node at 
which the displayed value is measured. 

• Delete View Node deletes traces from the simulation. 

• Create Bus groups traces for display as a single entity called a bus, used 
when thinking of groups of signals as a single value is more convenient. 
Bus values are only displayed when a measuring cursor is present. 

• Delete Bus un-defines a previously defined bus. 

• Edit Bus adds or removes signals from a bus. 

• Bus Radix specifies radix used to display a bus value. 
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These items are described in greater detail on the following pages. 

Node Defaults 
Create ~iew Node 
Delete View Node 
Create flus 
Delete Bys 

BUli Radix 

Figure 6-8 Nova Edit Menu 

Setting Signals High or Low 

With the Nova user interface, the user can easily set the value of all or a selected 
portion of an input signal to high or low. 

To set an entire input signal to high or low: 

• Click on the button containing the name of the signal in the Nova 
window to select it. On color monitors, the button changes color, and the 
trace turns blue when selected. On monochrome monitors, the button 
goes to inverse video, and the trace changes to a dotted line when 
selected. 

• Select High or Low from the Edit menu as desired, or type "1" or "D." 

To set a portion of an input signal high or low (see Figure 6-9): 

• De-select the signal. 

• Click and hold the mouse button on the trace at the left edge of the 
selected area. 

• Drag the mouse to the right edge of the selected area. 

• Then select High or Low from the Edit menu, as appropriate, or type "1" or 
"D. " 
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Both the left and middle buttons of a 3-button mouse perform the same action 
when clicked to position an edge. 

Figure 6-9 Setting a Portion of a Signal High or Low 

Top: press and hold the mouse button at the left edge of the selected area. Middle: 
drag to the right edge of the selected area, and release the mouse button. Bottom: 
select High or Low from the Edit menu, or type "1" or "0" from the keyboard. 

Setting Up Clock Signals (Repetitive Pulses) 

The Clock item under the Edit menu allows the user to set up repetitive pulses on a 
selected signal or portion thereof. 

To set up a repetitive pulse or clock signal, select a signal or a portion of a signal, 
then select the Clock item under the File menu. This brings up the Clock dialog box 
(Figure 6-10), which allows the user to fill in various repetitive pulse parameters. 

• Clock Period specifies the period of repetition for the pulse in simulator 
tics. 

• Clock Delay specifies the number of simulator tics to wait (beginning with 
the left edge of the selected area) before starting the repetition. The 
default is 0 tics. 

• Clock High Time specifies the amount of time that the selected signal 
should be set to 1 during each repetition. The default is 5. 

• Start High and Start Low specify whether each repetition starts with the 
signal set to 0 or 1. 

• OK sets up the repetitive pulse. 

• Cancel closes the Clock dialog box without affecting the trace. 

Warp User's Guide 261 



Nova 

6.5.3 

Clock Delay: ,1.-° ____ ----' 

Clock High Time: '1.-'_0 ____ ---' 

@ Start High 

o Start Low 

Figure 6-10 Clock Dialog Box 

Setting Up Non-Repetitive Pulses 

The Pulse item under the Edit menu allows the user to set up single pulses on a 
selected signal or portion thereof. 

To set up a single pulse on a signal, select a signal or a portion of a signal, then 
select the Pulse item under the File menu. This brings up the Pulse dialog box 
(Figure 6-11), which allows the user to fill in various pulse parameters. 

• Pulse Duration specifies the length of the pulse, in simulator tics. 

• Pulse Delay specifies the number of simulator tics to wait (starting from 
the start of the simulation) before applying the pulse. The default is O. 

• Start High and Start Low specify whether the pulse sets the signal to 0 or l. 

• OK sets up the pulse. 

• Cancel closes the Pulse dialog box without affecting the trace. 
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Pulse Duration: 
1
10 

Pulse Delay: 
1
0 

@ Start High 

o Start Low 

Figure 6-11 Pulse Dialog Box 

Nodes 

A node is an area of a circuit containing one or more points at which the user may 
wish to trace a signal. Nova allows the user to specify the exact point or points 
within a node at which to trace signal values, to set the default value of a node, 
and to force one or more positions in a node to known values. 

To Nova, a node is: 

• any input to an array 

• any output from an array 

• any pin on the device 

• any other electrical position that needs to be modeled but does not meet 
the first three criteria 

For each node, the user can: 

• create a view node, i.e., specify one or more positions within a node from 
which to trace values 

• specify the means by which a node is assigned its value 

• force any position in a node to a known value (this is often useful for 
multi-segment simulations) 

Each of these capabilities is discussed in greater detail on the following pages. 
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6.5.5 Selecting Node Points to View 

Many nodes contain several points at which the user can trace simulation values. 
Create View Node allows the user to select which of those points to view. 

A view node allows the user to see what is happening at various points inside a 
node. Selecting Create View Node brings up the Create View Node dialog box 
(Figure 6-12), which allows the user to select points to view within a selected 
node. To bring up this dialog box, the user must select a node with the current 
view set to FULL. (See Section 6.7, "The Views Menu," for information about 
changing views.) 

The Create View Node dialog box displays the node name with the view node 
name to be created directly below it. Nova creates the view node name by taking 
the node number, followed by a '-' and an extension to represent the selected 
signal to be displayed. 

The view node points that can be displayed depend upon the selected node. 
Examples of view node points that can be displayed include: 

• Data from Array - This is the data at the output of an OR-X OR combination 
of gates. Extension is "ardat." 

• Out value before OE - This is the data on the output pin if the output enable 
is asserted. This includes the output buffer inversion, if there is one. 
Extension is lib _oe." 

• OE Value - This is the state of the output enable. If high, OE is asserted so 
the output is driven. Extension is "oe." 

• Node Output - This is the data on the pin. This is the default view for 
output nodes. Extension is "OUt." 
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Node: 

1123-ardat 

1;1.1;;;1 

1'!'I&~li"1 

rSignalto be displayed is:------------, 

@ Data from array 

o Register value 

o Node output 

Figure 6-12 Create View Node Dialog Box 

Nova 

• Feedback at input - This is the data at the D input of the input register, if 
there is one. If there is no input register, feedback at input and feedback 
to array are identical. Extension is "fbkin." 

• Feedback to array - This is the data that is being fed to the array. It differs 
from feedback at input because it may be the other side of a register. 
Extension is "fbk_ar." 

Selecting OK closes the Create View Node dialog box and creates a view node, 
displayed at the end of the node list. Selecting Cancel closes the Create View Node 
dialog box without creating the view node. 

To delete a view node, select the view node to delete, then select Delete View Node 
from the Edit menu. 

Setting Input Node Values 

Node Defaults allows the user to specify the default source for the displayed value 
of anode. 

Selecting Node Defaults brings up the Node Defaults dialog box (Figure 6-13). 

Use the Change Default Input window of the Node Defaults dialog box to specify the 
source for the value of an input node. The current setting is shown highlighted 
within this window. 
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There are four possible settings for each input. They are: 

• High (1): tie the signal to Vee 

• Low (0): tie the signal to V ss (ground) 

• Use Simulation Record: use the value(s) in the simulation record ,sim file) 

• Other Node Record: tie the signal to another node. Enter the node number 
on the line to the right of the Other Node Record button 

Node: I;Il~!11111';;;:1 

1111 •• lll!1 
'-Change Default Input:-----------, 

o High (1) 

o Low (0) 

@ Use Simulation Record 

o Other Node Record L-lo __ ....J 

,-Jam Load:----------------, 

o Force Node High (1) 

@ Force Node Low (0) 

o Output Reg High (1) 

@ Output Reg Low (0) 

o lnpul Reg High fI} 

@ Input Reg Low (01 

o 2nd Input Reg High Pl 

@ 2nd Input Reg Low (01 

Figure 6-13 Node Defaults Dialog Box 
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Forcing Output Node Values 

Node Defaults also allows the user to force the value of an output node at a 
specified point. 

Selecting Node Defaults brings up the Node Defaults dialog box (Figure 6-13). 

Nova 

The Jam Load window of the Node Defaults dialog box can be used to force an 
output node to a specified value. Values of these nodes rarely need to be modified 
for normal simulations; however, for multi-segment simulation (for long counters 
and other long-period design) or if there are problems in Simulating the start-up 
condition of a circuit, the values may need to be changed. The current setting is 
shown highlighted. 

Depending on the type of node, it may be possible to select from Force Node 
High(l), Force Node Low(O), Output Reg High(l), Output Reg Low (0), Input Reg High 
(1), Input Reg Low (0), 2nd Input Reg High (1), and 2nd Input Reg Low(O). 

Working with Buses 

At times, grouping several traces in a simulation and viewing them as a single 
trace may be more convenient. This is possible with the Create Bus, Delete Bus, and 
Edit Bus options in the Edit menu. 

Selecting Create Bus brings up the Bus dialog box. This dialog box combines nodes 
into a user-named bus. The View list in the dialog box contains the names of all 
nodes in the current view. The Bus list holds the names of each node in the bus. A 
bus may be made up of any number of nodes. 

Selecting OK closes the Bus dialog box and creates a bus with the specified bus 
name. Buses are placed at the top of the trace area. Selecting Cancel closes the Bus 
dialog box without changing the trace area. It is not possible to input values to a 
bus. 

To add a node to the bus: select the node from the View list and select the Add» 
button. Double-clicking on the node name also adds the selected node to the bus. 
The new node is added below the selected nodes of the bus. 

~ Note - Nodes can be added only to a bus in the current view. 
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Clicking on the Add-by-Name button brings up a dialog box that asks the user to 
specify the name(s) of signals to add to the bus. The use of wild card characters is 
permitted. A I/?" matches a single character; a 1/*" matches any string of 
characters. The construct name[m:n] denotes a range of signals, numbered from m 
through n, beginning with the characters name. For example, I/input[O:3]" matches 
signals inputO, inputl, input2, and input3. 

To remove a node from the bus: Select the node to be removed and select the Cut 
button. Double-clicking on the node name in the Bus list also removes the node 
from the bus. 

To change a node's position in the bus: Select the node, then click Cut. Select 
another node, then click Paste. The node that was previously cut will be inserted 
below the newly selected node. 

To name the bus: Click on the line below the words Bus Name and enter the name 
for the bus. If no name is provided, the bus is named generic bus. 

To delete a bus: Select a bus trace by clicking on the bus name button or the bus 
trace. After the bus is selected, selecting the Delete Bus item from the Edit menu 
brings up a dialog box which can remove the bus from the trace area. 

Edit Bus brings up the same Bus dialog box used for creating the bus. The bus 
name line is filled in, and the nodes in the bus are displayed in the Bus list. Buses 
can be added, removed, or have their names changed from this dialog box. 

After all changes have been completed, selecting OK closes the bus dialog box and 
applies the modifications to the selected bus. Selecting Cancel closes the dialog 
box without updating the bus. 

Bus Radix brings up a submenu that allows the user to choose how bus 
information is displayed. The three choices are binary, octal and hexadecimal. 
Hexadecimal is the default. 
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6.6 The Simulate Menu 

The Simulate Menu has only one menu item: Execute. 

Selecting Execute from the Simulate Menu (Figure 6-14) simulates the design's 
operation. The Nova screen is redrawn, and the resulting waveforms are 
displayed. 

Figure 6-14 Simulate Menu 

6.7 The Views Menu 

Items in the Views menu allow the user to select the views (i.e., groupings of 
traces) in the trace area. 

The Views menu (Figure 6-15) contains five items: 

• Edit Views allows the user to create and edit views. 

• Select View allows the user to select a view to display. 

• Delete View allows the user to remove one or more views from the list. 

• Zoom In (2X) multiplies the displayed timescale resolution factor by two. 

• Zoom Out (1/2X) divides the displayed timescale resolution factor by two. 

Each of these items is discussed in greater detail in the following pages. 
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Figure 6-15 Views Menu 

Editing Views 

Edit Views allows the user to create new views and to add, remove, or exchange 
traces in existing views. 

Three views are automatically created with each .jed file: full, pins-only, and pins 
& registers. The full view (default) lists all nodes in the design. This view cannot 
be edited. The pins-only view contains only nodes that are attached to pins. The 
pins & registers view contains all nodes attached to registers or pins. 

Selecting Edit Views displays the Edit Views dialog box (Figure 6-16), used to edit 
the current view. The view list on the left displays the FULL view, which contains 
the default traces for all nodes. Use this list, along with appropriate buttons, to 
add or remove traces from the view list on the right. 

To create a new view: Click on New View. A name prompt will appear, which is 
placed at the top of the right-hand view list. 

To move between views: Click on Next View or Previous View. 
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To add a trace to a view: Select one or more traces from the left (Full) view 
window, then click Add». If a trace is also selected in the right window, the new 
traces are inserted after the selection; otherwise, the new traces are added to the 
end of the view. 

To remove traces from a view: Select the traces in the right window, then click on 
Cut. 

View: FULL 

0120 
0123 
0121 
0125 

13 elk 
0122 empty_1 
0124 empty_2 

35 get_cola 
11 get_diet 
2 give_cola 
3 give_diet 

0117jed_nodel17 
0118jed_node118 
0119jed_nodel19 
0149jed_node149 
0150jed_node150 
0159·ed node159 

View: PINS and REGS 

0120 bin_1_remainin! 
0123 bin_1_remainin! 
0121 bin 2 remainin! 
0125 bin=2=remainin! 

13 elk 
01 22 empty_1 
0124 empty_2 

35 get_cola 
11 get_diet 
2 give_cola 
3 give_diet 

0117jed_node117 
0118jed_nodel18 

4 refill_bins 
10 reset 

Figure 6-16 Edit Views Dialog Box 

To exchange (i.e., re-order) traces within a view: Select one or more traces from 
the right view window, then click Cut. Then, select another trace from the right 
view window and click Paste. The previously cut trace(s) are inserted after the 
selected trace. 
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Add-by-Name brings up a dialog box that asks the user to specify the name(s) of 
traces to add. The use of wild card characters is permitted. A I/?" matches a single 
character; a 1/*" matches any string of characters. The construct name[m:n] denotes 
a range of Signals, numbered from m through n, beginning with the characters 
name. For example,l/input[O:3]" matches signals inpu to, inpu tl, inpu t2, and 
inpu t 3. The user can also use multiple expressions separated by spaces. 

Deselect All unselects all selected traces in either window. 

Selecting OK closes the Edit Views dialog box and updates the trace area to reflect 
changes made to the view. Selecting Cancel closes the Edit Views dialog box 
without making any changes to the view. 

Selecting and Deleting Views 

Select View allows the user to change the active view. Delete View allows the user 
to remove a view from the list of available views. 

Select View brings up the Select View dialog box (Figure 6-17). The View line gives 
the name of the current view. To change the current view, select the desired view 
from the list, then click OK or type a carriage return. Clicking Cancel closes the 
Select View dialog box without affecting the active view. 

Delete View also brings up the Select View dialog box. Select the view to delete 
from the scrollable list. The FULL view may not be removed and is not included 
in this list. Clicking OK or typing a carriage return applies the change to the list of 
views. If the current active view is removed, the active view changes to FULL. 
Delete View has no undo, so the user should be certain the view being deleted is 
correct before clicking on OK or typing a carriage return. Cancel closes the Select 
View dialog box without deleting the selected view. 
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View: PINS and REGS 

FULL 
PINS ONLY 
PINS and REGS 

Figure 6-17 Select View 
Dialog Box 

Zoom In, Zoom Out 

Nova 

Zoom In doubles the time scale resolution of the trace window, i.e., by doubling 
the number of pixels in the X-axis used to display one tic of simulation time. The 
result is to /I zoom in" on the view of displayed traces. 

Zoom Out does the reverse of Zoom In. 

The resolution setting must be 1 or greater. The default is 5. Attempting to set the 
time scale resolution lower than 1 has no effect. 

6.8 The Options Menu 

The Options Menu contains items that allow the user to specify the simulation 
length, create or delete simulation segments, and specify the viewing resolution 
of the trace area. 
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The Options Menu (Figure 6-18) contains five items: 

• Simulation Length allows the user to set the length of the simulation. 

• Create Segment allows the user to create a segment, or "new-start-point," 
within the simulation. 

• Delete Segment allows the user to delete a previously created segment 
from the simulation. 

• Resolution allows the user to stretch and compress displayed traces. 

• Signal Name Size allows the user to specify the width in characters of 
Nova's signal name buttons. 

Each of these items is described in greater detail in the following pages. 

Figure 6-18 Options Menu 

Simulation Length 

Simulation Length allows the user to set the length of the simulation. 

Selecting Simulation Length brings up the Simulation Length dialog box (Figure 6-
19). 

The minimum and default simulation length is 256 tics. The maximum simulation 
length is 9984. Clicking on the up arrow adds 64 tics to the simulation length, to a 
maximum of 9984. Clicking on the down arrow subtracts 64 tics from the 
simulation length, to a minimum of 256 tics. 
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The user can also set the simulation length by typing a number on the line next to 
the up and down arrows. The number will be rounded downward to the nearest 
multiple of 64. 

Clicking OK closes the Simulation Length dialog box and sets the simulation length 
to be used on the next simulator run. Clicking Cancel closes the Simulation Length 
dialog box without affecting the simulation length. 

Figure 6-19 Simulation 
Length Dialog Box 

~-----------------
Note - Any repetitive input signals such as clocks should be 
respecified whenever the simulation length is increased. 

Creating and Deleting Segments 

Create Segment allows the user to create a segment, or "new start point," within 
the simulation. Delete Segment deletes a previously created start boundary. 

A segment is a point in the simulation at which various nodes are reset to their 
"jam load" values (set through the Node Defaults dialog box). 

To create a simulation segment, position the leftmost measuring cursor at desired 
beginning of the segment, then select Create Segment from the Options menu to 
bring up the Create Segment dialog box (Figure 6-20). The dialog box indicates the 
starting and ending boundaries of the segment. Selecting Yes closes the dialog box 
and creates the new simulation segment. Selecting No closes the dialog box 
without creating ~he segment. Up to 15 segments may be created. 
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To delete a segment, position the leftmost measuring cursor within the segment to 
be deleted, then select Delete Segment to bring up the Delete Segment dialog box 
(Figure 6-21). The dialog box indicates the segment boundaries for the segment to 
be deleted. Selecting Yes closes the dialog box and deletes the segment. Selecting 
No closes the dialog box without removing the segment. 

o CREATE SEGt.AENT from ~7 to 256 

Figure 6-20 Create Segment Dialog Box 

o DELETE SEGt.AENT from 66 to 255 

Figure 6-21 Delete Segment Dialog Box 

Resolution 

Resolution allows the user to stretch and compress displayed traces. 

Selecting Resolution from the Options menu brings up the Resolution dialog box 
(Figure 6-22). This dialog box allows the user to set the number of screen pixels on 
the X-axis to be used per simulation tic. Varying this number effectively stretches 
or compresses the traces displayed on the screen. 
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The pixels-per-tic setting may be any number between 1 and 100. The default is 5. 
The larger the number, the more "stretched" the traces appear; the smaller the 
number, the more compressed the traces appear. 

6.8.4 

Selecting OK closes the Resolution dialog box and updates the trace display. 
Selecting Cancel closes the Resolution dialog box without updating the trace 
display. 

Ira 

Figure 6-22 Resolution Dialog Box 

Signal Name Size 

Signal Name Size allows the user to specify the width in characters of Nova's 
signal name buttons. 

6.9 Nova JEDEC Simulator Quick Reference Sheet 

6.9.1 Simulating a Circuit 

• Start Nova. 

Select Nova Functional Simulator from the Galaxy tools 
menu or double-click on the Nova icon in the Windows 
program. 

• Load the JEDEC file which was produced from Warp. 

Select Open from the File menu. 
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• Edit Input Stimulus. 

To edit a signal, select the signal with the left mouse 
button. Go to the Edit menu to set the signal high or low, 
or to configure the signal as a clock. To edit portions of 
the signal, select the portion with the mouse, then type 
"0" or "1" to set that portion of the signal high or low. 
There is also a "pulse" feature which allows the user to 
set up single pulses. 

• Run Simulation. 

Select Exec;ute from the Simulate menu. 

Arranging Signals 

Using the Views menu in Nova, the user can choose what signals he wants to see 
and in what order they are displayed. The default views are FULL, PINS ONLY, 
and PINS and REGS. 

To create a new view, choose Edit Views under the Views menu and select New 
View. 

When creating a new view, wild cards are recognized. To enter all available 
signals, select Add by Name and type an asterisk ( "*"). Optionally, enter the 
names of the signals to see individually (or by using a combination of signal 
names and wildcards). 

When done, click on OK. This view can now be edited. To add new signals to the 
view, double-click on the signal on the left-hand side. To delete a signal, double
click on the signal in the view (on the right-hand side). Alternately, the user can 
cut and paste signals in the view. Signals are always pasted under the currently 
selected signal. 

The order of the Signals can be changed by using cut and paste or by using Add by 
Name. 
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6.10 Creating Buses 

• Select Create Bus from the Edit Menu. 

• Choose an appropriate bus name under the Bus Name field of the pop-up 
menu. 

• Add signal names to the bus by double clicking on the signal names on 
the left-hand side, selecting the signals, and clicking on Add, or by using 
Add by Name. Wildcards are allowed when using Add by Name. 

• Click on OK. 

If the signals are not in the current View, they cannot be added to a bus. 

These signals must be deleted from the view if the user does not want to see them 
individually. Don't do this if it's an input bus because buses are only useful for 
output. Data cannot be input as a bus, only as individual bits of a bus. 

To see the bus value, a measuring cursor is necessary. A measuring cursor is 
brought up by clicking the left mouse button in the white area near the bottom of 
the Nova window. During a single Nova session, the measuring cursor cannot be 
deleted once it has been activated. A second measuring cursor can be activated by 
holding the shift key down while clicking the left mouse button in the white area 
near the bottom of the Nova window. 

6.11 Miscellaneous 

To save input stimulus, view information, and buses for the next simulation, 
select Write Sim from the File menu. 

Nova is purely a functional simulator. There is no timing information in Nova. 
There is only the concept of simulation tics. A given device may be modeled as 
several smaller blocks. For instance, a FLASH370 device can be divided into 
smaller parts: 

• input cells 

• PIM 

• PTM 

• macro cell 

• I/O cell 
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As a result, the user may see a propagation between his input and his output. If 
the user experiences strange results, he should increase clock period or separate 
simultaneously changing input signals. Some rules of thumb (if there are 
problems) are to make pulses> 20 tics wide and provide> 10 tics of setup time. 

Color of traces: 

Blue means the waveform can be edited. 

White means an input or an output that is three-stated. 

Red means an output that is being driven. 

Pin numbers or node numbers are displayed to the left of the signal name. Zoom 
control is available under the Views menu. 

The simulation length may be changed by choosing Simulation Length under the 
Options menu. 

Printing Nova Output (PC): 

• Place the mouse cursor in the window to be captured. 

• Hit Alt and Print Screen simultaneously. 

This will place the window in a buffer. 

• Go into a text editor (MS Word/ Microsoft Write) and Paste from the 
buffer. 

• Print from the text editor. 
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The Warp tools use VHDL as the primary design entry mechanism. Warp3, 
however, also supports schematic entry as a design entry mechanism via 
ViewDraw. Warp3 also supports mixed-mode design entry where portions of the 
design are entered in VHDL and portions are entered in ViewDraw, graphically. 

When using ViewDraw, Warp3 provides a very powerful and sophisticated user 
interface that allows users to capture designs efficiently. With Warp3, the user 
can: 

• use VHDL descriptions, schematics, or both to describe any design 

• compile and synthesize the resulting design description 

• fit the resulting logic circuits into a particular PLD or CPLD, or place and 
route the design into an FPGA (the resulting files may be used for 
programming the device) 

• verify the design with a timing simulator 

There are several other tasks that can be performed, but this overview describes 
how to use View Draw for design entry. Figure 7-1 shows this process flow. 
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7.2.1 

8C::=>~ 
Schematics 

~tjrf 
VHDL Compiler 

rf ~ 
A 

Viewsim 

U 
Simulation Device Programmer 

Figure 7-1 Warp3 design flow 

LPM Library 

What Is LPM? 

Schematic Entry 

LPM is an acronym for Library of Parameterized Modules. This is a specification 
maintained by the Electronics Industries Association (EIA). The LPM 
specification contains a small set of highly parametrizable library elements. This 
specification is based on the EDIF (Electronic Design Interchange Format) version 
2.0.0 standard and also specifies how data containing these parameterized 
modules can be interchanged between third party CAE systems. 
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Cypress has chosen the LPM standard for its schematic library because of its 
flexibility and interoperability. Warp3 provides a graphical user interface to allow 
design entry with these LPM elements. With this graphical interface, the user can 
create, modify and manage LPM elements. To obtain a detailed description of the 
library and its functionality, the user should refer to Chapter 5, "LPM," of the 
Warp Reference Manual. 

The rest of this chapter assumes that the user is familiar with View Draw and the 
Powerview or Workview PLUS environment. 

How to Use LPM 

Since LPM is a set of parameterized elements where the number and width of the 
pins can be varied, and the View Draw schematic capture system does not allow 
the pins for a given symbol block to vary, Warp automatically and dynamically 
creates and maintains custom symbols that are pre-programmed for a specific 
use. 

For example, there is a common interface for an LPM_COUNTER. With this 
interface, the user can select or deselect many options such as enable, carry-in, or 
load. Instead of creating a symbol that has all possible pins for a given symbol, 
Warp automatically creates a custom symbol that has only those features required 
by the user. This is done because some of the LPM elements have a rather large 
number of optional features, and without a mechanism to create dynamic 
symbols, design entry with such symbols would be cumbersome. 

When the user requests an LPM symbol configured in a certain way, Warp creates 
this element and stores it in a special library called lpmlocal. The lpmlocallibrary 
consists of a set of symbols and data files that manage all the symbols in a user's 
private library. The names assigned to these dynamically created symbols are 
meaningful only to the software and do not imply anything about the symbol 
itself. The lpmlocallibrary should never be edited by users manually. Warp 
automatically creates and manages this information. 
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View Draw uses the viewdraw.ini file to locate libraries. ViewDraw searches the 
current project directory as well as the directories listed in the WDIR environment 
variable for this initialization file. This file contains, among other things, a set of 
library names and the directories where these libraries can be found. A sample 
viewdraw.ini file is shipped with Warp and can be found in the warpstd 
subdirectory where Warp is installed. A portion of this file is shown here: 

Format: DXR [DirType(s)] DirPath (LibName) 

DirType: p or pw - primary / writable 
w - writable (read/write) 
r - read-only 
m or r.m - read-only megafile 

DirPath: directory specification 

LibName: library name aka library alias or VHDL library 
name (optional) 32 characters or less. 
Must begin with a letters 

DIR [p] • 
DIR [r] c:\warp\lib\sheet (sheet) 
DIR [r] c:\warp\lib\io (io) 
DIR [r] c:\warp\lib\mcparts (mcparts) 
DIR [r] c:\warp\lib\prim (primitive) 

Lines starting with the " I" character are comments. The first directory below the 
comments is the current project directory, and the rest of the directories are 
libraries. To this list of libraries, another library must be added that represents the 
Ipmlocallibrary. This library must be writable by the user because Warp creates 
symbols dynamically on behalf of the user. An example of such a library would 
be: 

DIR [w] c:\mydir\~roj\lpmlocal (lpmlocal) 

where c:\mydir\myproj\lpmlocal is a directory where Warp stores the symbols it 
creates. Without a valid location for the Ipmlocallibrary, the Warp LPM 
functionality will be disabled. If th~s directory is being shared by other users in a 
network environment, this directory must be writable by everyone using this 
library. The viewdraw.ini file should be copied to the current project directory, 
and then this change should be made to the file. 
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Creating the Ipmlocal Library 

When View Draw is invoked for the first time in a new View logic project, the LPM 
functionality is disabled and step-by-step instructions are printed on how to 
enable the LPM functionality and the creation of the lpmlocallibrary. 

Creating an LPM Element 

To create an LPM element once View Draw has been opened for editing a 
schematic, use the menu item Add->LPM Symbol. 

Figure 7-2 Add LPM Symbol 
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When this menu item is selected, View Draw prompts the user for the type of 
module to be instantiated. This dialog box is titled Add Cell and is shown in the 
following figure: 

Figure 7-3 Add Cell dialog box 

The user selects the desired module by single clicking the left mouse button. This 
action results in another dialog box that prompts the user to enter all the options 
that are applicable for the module selected. For example, if the Mcounter module 
was selected, the following dialog box would pop up: 

Figure 7-4 Mcounter dialog box 
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After selecting the appropriate items in this dialog box, a single mouse click on 
the Accept button removes this dialog box. At this point, the custom symbol that 
Warp has dynamically created is attached to the cursor and is ready to be placed 
in the schematic. 

Modifying an LPM Element 

If the user wishes to modify an LPM symbol already placed in the schematic, he 
should first select the LPM symbol to be modified and then choose the 
Change->LPM Symbol menu item. Only one LPM symbol may be selected at a 
time. When this menu item is selected, Warp displays the appropriate dialog box 
for the given LPM symbol, identical to the dialog box that was used during the 
initial creation of the LPM symbol. 

Creating/Modifying a Non-LPM Element 

A non-LPM element is essentially a user or library symbol which does not 
constitute a parameterized symbol. Instances of these elements are created using 
the regular ViewDraw methods. The Add->Comp menu item is used to create an 
instance of a non-LPM symbol, and the Change->Comp menu item should be used 
to change an existing instance. These menu items should not be used to edit or 
create instances of LPM symbols. Other than this restriction, an LPM symbol is 
similar to any other symbol within View Draw. 
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7.3 Exporting the Schematic 

Once the schematic has been completed, the design can be converted into VHDL 
and compiled into a PLD, CPLD, or FPGA device. This can be accomplished by 
using the menu item Cypress->Export VHDL: 

Figure 7-5 Export VHDL menu selection 
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When this option is selected, the following dialog box pops up: 

Figure 7-6 Export VHDL dialog box 

In this dialog box, Design Name is simply the name of the schematic being 
netlisted and Output Directory is the directory in which the netlist should be 
created. Leaving the Output Directory blank will create the netlist in the current 
project directory. 

At this time, the user can also choose the type of netlist to be produced by the 
netlister. Currently, two types are supported: bi t and std_logic. In VHDL, 
each signal has a type associated with it. This option simply allows a choice 
between these two different types. The bit type is supported only fpr 
compatibility with the previous release. The std_logic type is recommended 
for all new designs. 

Clicking the left mouse button on the button marked Accept will cause the 
following actions: 

• Check and Save the current schematic if it is not already saved. 

• Invoke the batch program hil076 to perform the actual netlisting. 

• Netlist any synthesis directives found in the design. 

The output file name has the same name as the top level design with a .vhd 
extension. This file also contains a hierarchical netlist for all the lower level 
blocks. Once this file is created, the design is ready to be synthesized using the 
Warp compiler. 
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7.4 Back-Annotation 

Once a design has been successfully placed into a device, Warp allows the user to 
fix the pinout for that design. 

To back-annotate pin-numbers into the design schematic, the user must select the 
menu item Cypress->Back-Annotation .... 

Figure 7-7 Back-Annotation menu selection 

A simple dialog box appears showing the design name to be back-annotated. 
Clicking on OK does the following: 

• Invokes a batch program that queries the pinout results and creates a list 
of pin names and their associated pin-numbers. 

• Edits the current schematic (and all its associated sheets) to place the # 
attribute, so that future VHDL netlisting will force the pins to be placed in 
the same location. 
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The buses are back-annotated in a special way. Buses require that multiple pin
numbers must be back-annotated. This is accomplished by creating an attribute 
with a "," (comma) separated list of pin-numbers. 

~-----------------
Note - Back-annotation will have no effect if the design has not 
been successfully fit or placed and routed into a device. 

7.5 Using the Schematic Libraries from Release 3.5 
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The release 3.5 library and the release 4.0 library elements are not compatible with 
each other. To use the release 3.5 library mechanism, the user must do the 
following: 

On the PC 
In the Warp R4 Program Group, invoke the program item named Library. This 
program will modify the viewdraw.ini file located in the c:\warp\warpstd 
directory as well as reconfigure the library directory in preparation for synthesis 
using the appropriate library. This will allow the user to create a new project 
directory via the Cockpit configured for either the release 3.5 or 4.0 library. 

On UNIX Systems 

The user must first login as the user who installed Warp on the system, to ensure 
that he has the proper permissions to modify the installation directory and then 
execute the program cypver. This assumes that $CYPRESS_DIR/bin is in the 
user's path and that the environment variable $CYPRESS_DIR is pointing to the 
Warp installation directory. The cypver command modifies the Warp 
installation allowing the user to switch between the 3.5 and 4.0 libraries. 

The above programs do not automatically modify all projects and any 
viewdraw.ini files that might exist in those directories. Following the template 
provided in $CYPRESS_DIR/warp/warpstd/viewdraw.ini, the user must modify 
his own viewdraw.ini files. 
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7.6 Schematic to Symbol 

In Warp3, the user can use the Schematic to Symbol found in the Cypress menu to 
generate a symbol for a schematic circuit. The resulting symbol can then be 
instantiated in other, higher-level schematics. 

When Schematic to Symbol is run, a dialog box allows the inputs and the outputs of 
the symbol to be reordered. Once the ordering of the pins is satisfied, clicking on 
Accept will create the symbol. 

Figure 7-8 Schematic To Symbol dialog box 

~----------------
Note - A new symbol cannot be generated if the symbol is 
already loaded into View Draw. To work around this problem, 
simply close all other ViewDraw windows or re-renter View-
Draw and only load the schematic for which the symbol is 
needed. 

7.7 VHDL To Symbol 

The VHDL To Symbol utility can be invoked in ViewDraw under the Cypress 
menu bar. This utility differs from the View logic VHDL2sym tool, which can be 
found in the Circuit Design drawer. The Cypress version of the VHDL To Symbol 
translator requires that the VHDL file be first compiled using Galaxy as a non top
level file. 
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When this utility is invoked, a list of VHDL components for which symbols can be 
generated is displayed so that the user can select exactly which symbols need to 
be generated. If errors have been detected for symbols, the dialog box for VHDL 
To Symbol allows viewing these errors. The order of the pins for each of the 
symbols is determined by the order in which they were listed in the VHDL file. 
Please note that these VHDL components must be defined within a package. 

This utility is useful for designing in a bottom-up fashion, in which the user starts 
at the lowest level (being VHDL) and works up to a top-level graphical schematic. 

~----------------
Note - A new symbol cannot be generated if the symbol is 
already loaded into ViewDraw. To work around this problem, 
simply close all other ViewDraw windows or re-renter View-
Draw and only load the schematic for which the symbol is 
needed. 

To run VHDL To Symbol, invoke the VHDL To Symbol and enter the name of the 
VHDL file (without the .vhd) extension. 

7.8 Symbol to VHDL 

294 

Symbol to VHDL takes as input the name of a symbol, and translates a ViewDraw 
symbol into a VHDL file. The VHDL file has the same name as the symbol, except 
with a . vhd extension. This implies that the symbol name should be a VHDL legal 
name. The VHDL entity name is the same as the symbol name. 

Figure 7-9 Symbol to VHDL dialog box 
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7.9 Update Library 

Since the Ipmlocallibrary contains symbols that are sequentially named as the 
user requests new LPM symbols, it is highly likely that two different users using 
different Ipmlocallibraries can have a like-named LPM symbol whose feature set 
may be completely different. Furthermore, a symbol with a given feature set may 
exist in one library and not in the other. Sharing or transporting of user 
schematics would therefore be impossible. To solve this problem, Warp provides 
a synchronization utility. Whenever a schematic is imported from another user, 
selecting the Cypress-> Update LPM Symbols will ensure the integrity of the current 
schematic and its hierarchy by resolving any conflicts and regenerating all of the 
LPM symbols. 

Figure 7-10 Cypress Update LPM Symbols 

7.10 Print Hierarchy 

This menu item prints the hierarchy for a schematic. This is helpful in being able 
to view a schematic's organization when the schematic contains many lower level 
schematics or modules. Please note that this utility cannot analyze the hierarchy 
of VHDL modules. 
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8.1 Introduction 

298 

Warp supports pre-synthesis VHDL simulation and post-synthesis VHDL and 
Verilog simulation. For post-synthesis simulation, Warp adheres to the following 
methodology: it generates all the VHDL and Verilog files required to simulate the 
design, and provides an easy way to integrate these HDL (Hardware Description 
Languages) files into the target simulation environment. In order to simulate the 
design, the user should be familiar with the desired simulation environment. 

The VHDL and Verilog simulators supported are listed in Tables 8-1 and 8-2, 
respectivel y. 

Table 8-1 Supported VHDL simulators 

Simulator Vendor Pre-fPost-synthesis 

ViewSim Viewlogie Post-synthesis 

SpeedWave ™ Viewlogie Pre-fPost-synthesis 

V -System ny QuickHDLTM Model Technology f 
Pre-fPost-synthesis 

Mentor Graphics 

VSSTM Synopsys Pre-fPost-synthesis 

Leapfrog ™ Cadence Pre-fPost-synthesis 

IEEEl164 VHDL N/A Pre- f Post-synthesis 

Table 8-2 Supported Veri log simulators 

Simulator Vendor Pre-fPost-synthesis 

VeriBest Intergraph Post-synthesis 

VCS ™ f Chronologie View lo gic Post-synthesis 

Verilog-XL ™ Cadence Post-synthesis 

IEEE1364 Verilog NfA Post-synthesis 

Unless otherwise specified, pre- and post-synthesis simulation support is 
available for all deviees. 
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8.2 Pre-synthesis Simulation 

V-System 

Scripts for compiling the Cypress pre-synthesis libraries into the user's work 
directory are available in $CYPRESS_DIR/warp/lib/prim/presynth/scripts 
(c:\warp\lib\prim\presynth\scripts). On UNIX platforms, to build the complete 
library for STD _LOGIC types, run the following command: 

$CYPRESS_DXR/lib/prim/presynth/scripts/vsys_std 

This command will compile all the necessary files in a work directory at the 
current location. 

Thestd_logic_1164, std_logic_arith, std_logic_unsigned, 
numeric_bi t, and numeric_std packages are already part of the compiled 
ieee library and accelerated for V-System/Workstation V4.4g (V-System/VHDL 
Windows V4.3g). 

On PCs, for the Windows version of V-System, invoke the V-System, pull down 
the File->Directory and select the directory in which the library is to be compiled. 
Then in the Transcript window, the following is entered (note the ~/do" 
command): 

do c:\warp\lib\prim\presynth\scripts\vsys_std 

Similarly, to run pre-synthesis simulation using BIT types, use the following 
commands: 

(V-System/UNIX Workstation) 

$CYPRESS_DXR/lib/prim/presynth/scripts/vsys_bit 

(V-System/VHDL Windows) 

do c:\warp\lib\prim\presynth\scripts\vsys_bit 

If the user already has command files written for ViewSim or SpeedWave ,cmd), 
they can be easily converted to V-System ,do) files. In order to make this 
conversion seamless, the user must not use the shorthand commands for 
ViewSim (i.e., a for assign, c for cycle, 1 for low, h for high, etc.). If the longhand 
conventions are used, they will map directly to the .do file syntax. 

Warp User's Guide 299 



Simulation 

300 

SpeedWave 

Scripts for compiling the Cypress pre-synthesis libraries into the user's work 
directory are available in $CYPRESS_DIR/lib/prim/presynth/scripts. To build the 
complete library for STD_LCX;IC types, run the following command: 

$CYPRESS_D~R/lib/prim/presynth/scripts/spwv_std 

This command will compile all the necessary files in a work directory at the 
current location. 

To run pre-synthesis simulation using BIT types, run the following command: 

$CYPRESS_D~R/lib/prim/presynth/scripts/spwv_bit 

These commands will build the necessary directory for pre-synthesis simulation 
of the user's design. If the user already has command files for ViewSim, they can 
be used with SpeedWave with minor changes. All port signals must be prefixed 
with a / in the SpeedWave command file. This change is not backward 
compatible with ViewSim. 

Before running the above scripts, make sure that the environment variable 
V ANTAGE_ VSS is set correctly, to point to SpeedWave root directory. 

Other Simulators 

For the rest of the simulators specified in Table 8-1, compile the packages in 
$CYPRESS_DIR/lib/prim/presynth/std or $CYPRESS_DIR/lib/prim/presynth/bit (on 
PCs, c:\warp\lib\prim\presynth\std or c:\warp\lib\prim\presynth\bit) and the 
VHDL design file into your work library and simulate using the target simulator 
commands. The proper order of compiling these files can be obtained by looking 
at one of the scripts in $CYPRESS_DIR/lib/prim/presynth/scripts 
(c:\warp\lib\prim\presynth\scripts). The process for other simulators is similar to 
that mentioned above. 
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8.3 Post-synthesis Simulation Design Flow for PLDs and CPLDs 

The design flow for the post-synthesis simulation support for Cypress PLD and 
CPLD devices is shown in Figure 8-1. 

Select design and 
simulator in Galaxy 

Compile and synthesize 

verilog files in vlg directory 
vhdl files in vhd directory 

Compile and simulate 
in target simulation 

environment 

Figure 8-1 Simulation design flow for PLDs and CPLDs 

8.3.1 Select a Design 

8.3.2 

Refer to Chapter 4, "Galaxy," for details on how to select a design and a device. 

Select a Simulator 

The supported simulators are listed in the Devices dialog box of the Galaxy 
window, under the Post-JEDEC Sim section. Select the target device and package 
from the Device and Package menus, respectively, and the simulator from the Post
JEDEC Sim menu. 
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8.3.3 

8.3.4 

Compile a Design 

After selecting the design, target device, and simulator, compile the design from 
the Galaxy window. Warp creates a set of VHDL or Verilog files which are 
required for simulation in the vhd or vlg sub-directories, respectively. The vhd and 
vlg sub-directories are created automatically if they do not already exist. The 
filenames for the post-synthesis simulation models will have the same base name 
as the top-level design file. 

VHDL Simulation 

V-System 

A script for compiling the Cypress post-synthesis primitive libraries into the 
user's primitive directory is available in $CYPRESS_DIR/lib/prim/presynth/scripts/ 
vsysprim (on PCs, c:\warp\lib\prim\presynth\scripts\vsysprim). On UNIX 
platforms, to build the complete primitives library run the following command: 

$CYPRESS_DiR/lib/prim/presynth/seripts/vsysprim 

This command will compile all the necessary files in a primitive directory at the 
current location. 

On PCs, for the Windows version of V-System, pull down the File->Directory and 
select the directory in which the library is to be compiled. Then in the Transcript 
window the following is entered (note the "do" command), write the following 
command: 

do e:\warp\lib\prim\presynth\seripts\vsysprim 

Once the primitive library has been built, the target design can be compiled 
(vcom) and simulated (vsim) with commands such as the following: 

• veom vhd\<file name>.vhd 

• vsim <entity name> 
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SpeedWave . 
A script for compiling the Cypress post-synthesis primitive libraries into the 
user's primitive directory is available in $CYPRESS_DIR/lib/prim/presynth/scripts/ 
spwvprim. To build the complete primitives library run the following command: 

$CYPRESS_DZR/lib/prim/presynth/scripts/spwvprim 

Once the primitive library has been built, the target design can be compiled into a 
selected work area using the following command: 

analyze -dbg 2 -libfile vsslib.ini -src vhd/<file name>.vhd 

The simulation process at that point is the same as for ViewSim simulation. 

Other Simulators 

For the rest of the simulators specified, compile the packages in $CYPRESS_DIR/ 
lib/prim/vhdl (on PCs, c:\warp\lib\prim\vhdl) and the VHDL design file into your 
primitive library and simulate using the target simulator commands. The proper 
order of compiling these files can be obtained by looking at one of the scripts in 
$CYPRESS_DIR/lib/prim/presynth/scripts/*prim (on PCs, 
c:\warp\lib\prim\presynth\scripts\ *prim). The process for these other simulators 
is similar to that mentioned below for Verilog Simulation. 

Verilog Simulation 

In order to simulate the design, the user should be familiar with the target 
simulation environment. When a Verilog simulator is selected, Warp creates a 
template file which assists the user in submitting the correct set of Verilog files, in 
the proper order, to the target Verilog compiler. The template file, whose name 
and format vary with the target simulator, is created in the vlg directory. The 
steps needed to compile the design in different simulator environments are 
described below. 

VeriBest 

The template file that Warp creates is called design_name.sup. Its format is 
conformed to the support file format within VeriBest (refer to the VeriBest 
simulator manual for details). Load the support file into the VeriBest environment 
(File->Open_Setup_File) and select the analyze command to compile. The design is 
now ready for simulation in the VeriBest environment. 
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ves 
The template file that Warp creates is called design_namefls. This file contains the 
list of files and their respective order to be compiled with the Verilog compiler. 
Specify this file name in the ves command line, as shown below. 

Verilog-XL 

The template file that Warp creates is called design_namefls. This file contains the 
list of files and their respective order to be compiled with the Verilog compiler. 
Once the files are compiled, they are ready for simulation in the Verilog-XL 
environment. 

~-----------------
Note - Make sure that the vlg directory is in the search path of 
the target simulator. 
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8.4 Post-synthesis Simulation Design Flow for FPGAs 

8.4.1 

8.4.2 

8.4.3 

The design flow for the post-synthesis simulation support is shown in Figure 8-2. 

Select design and device in Galaxy 

Compile and synthesize 

Select simulator, in SpDE 

Compile and simulate 
in target simulation 

environment 

Figure 8-2 Simulation design flow for FPGAs 

Select a Design 

Refer to Chapter 4, "Galaxy," for details on how to select a design and device. 

Compile a Design 

After selecting the design and target device, compile the design from the Galaxy 
window. 

Select a Simulator 

A variety of simulators are supported for post-synthesis simulation. The 
supported simulators are listed in the Tools->Options->Simulator dialog box 
within the SpDE place and route tool. Select the target simulator from this menu. 
See Chapter 5, "SpDE" for more information on the SpDE place and route tool. 
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8.4.4 

8.4.5 

8.4.6 

8.4.7 
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Run SpDE 

After selecting the simulator, run SpDE with the back-annotation tool selected. 

ViewSim Simulation 

Warp3 integrates directly into the View logic Powerview and Workview PLUS 
environments, and FPGA post-synthesis simulation is fully supported with the 
ViewSim simulator. After running SpDE, the spde2vl executable must be run. 
lIDs program is run by double-clicking on the pASIC-> VSim icon in the Cockpit. 
lIDs utility will generate the necessary files for ViewSim simulation. 

VHDL Simulation 

For VHDL Simulation, simply select the appropriate simulator from the SpDE 
Tools->Options->Simulator menu and run the back-annotation tool from within 
SpDE. This will create a . vhd file and a .sd! file compliant with the VITAL 
specification. These files in conjunction with the VHDL primitive models 
provided allow the user to simulate a design with any VITAL compliant VHDL 
simulator. 

Verilog Sim ulation 

When a Verilog simulator is selected, Warp creates a verilog design file (design.vq) 
and a delay back-annotation file (design.sd!) where design is the top-level design 
name. The device specific primitives used in the design are available in 
$CYPRESS_DIR/spde/data/qlprim.v (on pes, c:\warp\spde\data\q\prim.v). To 
simulate the design, compile design. vq and the above mentioned primitive file in 
the target simulator environment. 
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8.5 Post-synthesis VHDL Simulation in ModelT Environment 

The following are the steps required for post-synthesis /layout simulation of 
pASIC targeted designs with Model T's V-System: 

• A qlprims library needs to be created with the mtiprim.vhd file which is 
supplied by Cypress. Follow these steps: 

Create a qlmodel directory. 

Copy the file mtiprim.vhd (from $CYPRESS_DIR/spde/data) to the qlmodel 
directory. 

While in the qlmodel directory, create a new library called qlprims with the 
V-System's vlib. 

vlib qlprims 

Map the qlprims library to it's source: 

vmap qlprims <path>/qlmodel/qlprims 

Compile the mtiprim. vhd file to the qlprims library: 

vcam -work qlprims mtiprims.vhd 

• Load design «design.qdf» into SpDE and select Model Tech V-System 
from the Tools -> Options -> Simulator menu. SpDE will create 
<design>.vhq and <design>.sdf files when the tools are run. 

~-----------------
Note - As SpDE creates the .vhq file, it may inform you that vec-
tors in your entity will be broken out into individual signals 
unless you have a . vhh file. Please ignore these messages as this 
feature is not yet supported by Warp. 

• Compile <design>.vhq: 
vcom <design>.vhq 

• Simulate: 
vsim -t ps -sdftyp/-sdfmin/-sdfmax <design>.sdf 
<design> 
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~----------------
Note - '-t ps' must be used because timing numbers in the SDF 
file are in picoseconds. Because of this you must be careful about 
the default cycle time which is 100 time units (in this case lOOps). 
Either reset the default time units/ cycle or explicitly indicate a 
time for your 'run' statements in the .do file to prevent surprises. 

8.6 Post-synthesis Verilog Simulation In VeriBest Environment 
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Following are the steps involved in the post-synthesis simulation of a CPLD 
targeted design in the Intergraph VeriBest environment. 

• Select Intergraph from Devices dialog box of Galaxy and compile the 
design. 

• Create a test bench model to give test vectors to the design. Following is a 
test bench model: 

module <design>_tbench () ; 
II test bench name is <design>_tbench 

reg inl, •••• ; 
wire out 1 , •••• , 

initial 
begin 

II specify test vectors 
end 

II instantiate the design 
<design> instl (inl, ••••• , outl, ••••• ) ; 

II In the above, <design> is the Verilog model name 
of the design. It is created by Warp and is in 
the file <design>.vlg in vlg sub-directory 

endmodule 

• Load and compile the Verilog files generated by Warp into the Veribest™ 
environment and simulate the design. 
% veribld 

File->Open_Setup_File <design>.sup 
Analyze 
Simulate 
II in the above, File, Analyze, Simulate are the 

menu buttons in veribld 
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Following are the steps involved in the post-synthesis simulation of a pASIC 
targeted design in the Intergraph VeriBest environment: 

• Load design «design>.qdf) into SpDE and select Verilog from the 
Tools->Options->Simulator dialog box of SpDE 

• Run SpDE tools from Tools->Run Tools dialog box making sure that the 
back-annotation option is selected. 

• Create a test bench model to give test vectors to the design. The following 
is a test bench model: 

module <design>_tbench () ; 
II test bench name is <design>_tbench 

reg inl, •••• ; 
wire outl, •••• , 

initial 
begin 

II specify test vectors 
end 

II instantiate the design 
<design> instl (inl, ••••. , outl, ••••• ) ; 

II In the above, <design> is the Verilog model name 
of the design. It is created by SpDE and is in 
the file <design>.vq 

II Include <design>.sdf file generated by SpDE 
initial 
begin 
$sdf_annotate("<design>.sdf",<design>_tbench.instl} ; 
end 

endmodule 
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• Load and compile the Verilog files generated by SpDE into the Veribest 
environment and simulate the design. 
% veribld 

Add->$CYPRESS_DIR/spde/data/qlprim.v 
Add-><design>.vq 
Add-><design_tbench> 
Analyze 
Simulate 

II in the above, Add, Analyze, Simulate are the 
menu buttons in veribld 

~-----------------
Note - Refer to the Verilog language reference manual and Simu-
lator guide for details of test bench model and simulator usage. 

310 Warp User's Guide 



Synthesis 



Synthesis 

~9.1 

9.1.1 
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Synthesis Directives 

This chapter introduces synthesis directives-what they are, what they are used 
for, how to use them, and when to use them. This chapter is organized into five 
sections. The first section is an introduction. It explains directives and discusses a 
strategy for using them effectively. It also includes two design examples to 
illustrate how to apply them. The second section describes those directives that 
can be used to optimize a design for the fewest device resources. The third section 
describes those directives that can be used to optimize a design for timing goals, 
including operating frequency, clock to output delay, setup time, and 
combinatorial propagation delays. The fourth section describes directives used 
for controlling the type and location of specific resources used in a device. The 
final section describes directives used for documentation, including part selection 
and pin number assignment. 

Understanding Synthesis Directives 

Synthesis directives may be used to influence the implementation of a design. 
They are used in an iterative fashion to refine, improve, or constrain the results of 
synthesis. For example, the goal directive is used by the synthesizer to select 
either area-efficient or speed-efficient design implementations. Synthesis 
directives may be applied to components that have been either instantiated in a 
schematic or inferred by the synthesizer from VHDL code. The buffer_gen 
directive causes buffers to be inserted for high-fanout signals. Synthesis_off 
creates a factoring point for logic equations and is used for area or speed 
optimization (or both). The pin_numbers directive specifies the pin numbers to 
be used for signals. These and other directives are discussed in the pages to 
follow, but the following section discusses a strategy for designing with synthesis 
directives. 
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9.1.2 Design Flow and Strategy for Using Directives 

Directives are a powerful mechanism to influence the synthesis process, but they 
should be used judiciously. Careless or excessive use of directives can, in fact, 
subvert the very design goals that are sought. This section describes a strategy for 
using directives and choosing the appropriate one(s) to achieve the user's goals. 

Until the user becomes familiar with the effects of using the different directives, 
Cypress does not recommend applying any of them in the first iteration of a 
design. After synthesis and fitting-or place and route, in the case of an FPGA 
design-the design may fit in the desired device and meet timing goals. In this 
case, the design is complete-no directives are necessary. If, however, after the 
initial iteration of synthesis and fitting, the design does not fit or meet timing 
goals, the design may need tuning. Tuning, illustrated in Figure 9-1, is the process 
of (1) identifying and applying an appropriate directive that may help to reduce 
resource utilization or realize timing targets, (2) resynthesizing and fitting the 
design, and (3) verifying that the design meets area and speed goals. In some 
cases, this tuning process may have to be repeated in order to compare multiple 
implementations of the design. 
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9.1.3 Available Directives 

Table 9-1 can be used to select an appropriate directive for tuning a design. Those 
directives listed first are most likely to have the greatest impact on a design 
implementation and should be selected first when tuning. The other directives are 
used in special cases or for documentation purposes. Device selection and pin 
number assignment are included in the documentation category, a1 though they 
are also functional directives that can have a significant impact on area and speed. 
Later in this chapter, each of the directives listed in the table is explained in 
greater detail, with the focus on understanding scenarios when using a particular 
directive is appropriate. The syntax and effect of all directives is explained in 
"Synthesis Directives," Chapter 3, of the Warp Reference Manual. 

For each of the directives listed in Table 9-1, the "Applicable Devices" column 
indicates whether the directive is useful for CPLDs, FPGAs, or both. The "Used 
for ... " column indicates whether the directive can be used for area optimization, 
speed optimization, specific control, or documentation. 

The next section describes how to apply directives. 
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Table 9-1 Available Synthesis Directives 

Applicable 
Used for ... 

Directive Devices 

CPLDs FPGAs area speed control doc. 

goal x x x x 

state_encoding x x x x 

buffer_gen x x x 

max_load x x 

pad_gen x x x 

synthesis_off x x x x x 

do nt_touch x x x x 

no_latch x x x x 

lab_force x x 

pin_avoid x x 

polarity x x 

sum_split x x 

node_num x x 

fixed_ff x x 

fCtype x x 

no_factor x x x 

opt_level x x x x x 

part_name x x x x x 

order_code x x x x x 

pin_numbers x x x x x 
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Scope and Inheritance 

Each of the synthesis directives has a scope: some are intended for signals, others 
for components. Some of the directives also have an inheritance. A directive 
intended for a signal can be placed on an architecture or entity so that all signals 
defined in that architecture or entity inherit that directive. This is called 
hierarchical inheritance. Not all directives have an inheritance, however. Non
hierarchical directives are meant for the exact object that they are attached to and 
will be ignored if not applied to the appropriate object. 

Hierarchical directives have the following order of precedence (from least to 
greatest): 

• entity 

• architecture 

• component declarations 

• component instantiations 

• signals 

Thus, a hierarchical directive placed on an architecture is overridden by a 
directive placed on a signal within that architecture. In other words, a hierarchical 
directive intended for a signal, if placed on an architecture, serves as a default for 
all signals within that architecture. Likewise, a hierarchical directive placed on a 
component instantiation overrides a directive placed on an architecture. This 
allows for an occurrence of a component to have a different value than the default 
directive for all components. 

Applying Directives 

Some directives are available via the command line or Galaxy switches. Warp also 
provides three other methods for applying synthesis directives: with VHDL 
attributes, with schematic attributes, or with a top-level control file. Values of 
directives passed through the GUI or the command line act as default values. 
Directives applied using VHDL attributes, schematic attributes, or the control file 
override default values. The only exceptions are the part_name and 
order_code directives. The GUI or command line, discussed below, will 
override all part_name and order_code attributes. 
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Using the GUI or command line. Certain directives may be controlled from the 
GUI or command line. An example of this is the goal attribute which can be 
selected to provide area or speed optimization. If speed is selected, then it 
becomes the default value. If a component has a VHDL or schematic goal 
attribute applied to it, however, and the value of the attribute is area, then the 
speed value is overridden with the area value for that component. 

Using VHDL attributes. VHDL permits the use of user-defined attributes to 
adorn objects with information. Warp has thus created a user-defined (as opposed 
to pre-defined) attribute for each directive. This permits a directive to be applied 
to an object with the use of an attribute. The general syntax of an attribute used to 
place a directive on a signal is the form: 

attribute directive_name of object:class is value; 

Such attributes are placed in the appropriate declarative region of the VHDL 
code, typically in either the entity declarative region or the architecture body 
declarative region. The object is the actual name or identifier of the entity, 
architecture, component instantiation label, or signal. Class is used to identify the 
class of the object (i.e., entity, architecture, or component instantiation label, or 
Signal). 

Examples of applying directives using attributes are given below. Next is a 
discussion of the application of directives with schematic attributes and a top
level control file. 

Using schematic attributes. Directives may be applied to objects in schematics 
(with Warp3) using attributes by selecting the appropriate object and choosing 
Attribute from the Add menu. After selecting Add->Attribute, a dialog box appears 
in which the user may enter the directive in the form: 

direct ive_name =value 

The goal directive for area or speed optimization is not applied as an attribute. It 
is chosen through the Add->LPM Symbol dialog box. The directive chosen here 
overrides the command line or GUI switch. 
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Using a control file. A top level control file may also be used to specify synthesis 9 
directives. In the case of conflict, directives placed in a control file override 
directives specified with VHDL or schematic attributes. The format of the control 
file is defined in Chapter 3, "Synthesis Directives," of the Warp Reference Manual. 
Each directive may be applied in the control file using a syntax similar to that of 
attributes: 

attribute directive_name [of] object[:class] is value[;] 

The words in square brackets [ ] are optional and are simply ignored. Specifying 
the class is also optional. 

The next section illustrates how to apply directives in a design by using the 
tuning strategy shown above. The two examples shown below demonstrate the 
merits of both CPLDs and FPGAs. These design examples were compiled using a 
pre-release version of the Warp software. Your results may vary slightly from 
those presented here, but the general concepts will remain true. 

9.2 Example 1-0RAM Controller 

The code of the following listing is used to describe a fictitious DRAM controller. 
Understanding the details of the code is not necessary for comprehending the 
subsequent design optimization strategy. This example will first optimize this 
design for a pASIC380 FPGA and then retarget it to a FLASH370 CPLD. 

library ieee; 
use ieee.std_logic_1164.all; 
entity example is port( 

clk, rst, ads, burst:in std_logic; 
address: in std_logic_vector(3i downto 0); 
cas, ras, ack, ref: buffer std_logic; 
row_col_address:out std_logic_vector(ii downto 0»; 

end example; 

use work.std_arith.all; 
architecture controller of example is 

type states is (idle, 'asdet, rasa, casa, wi, w2, w3, 
nocas, refad, wri, wr2); 
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signal state, next_state: states; 
signal match, ref_req:std_logic; 
signal count: std_logic_vector(23 downto 0); 
signal captured_address: std_logic_vector(31 downto 0); 
signal captured_burst:std_logic; 
signal col_ad:std_logic_vector(ll downto 0); 
signal burst_cnt:std_logic_vector(l downto 0); 

constant re_ad:std_logic_vector(ll downto 0) := (others 
=> '0'); 

alias row_ad: std_logic_vector(ll downto 0) is 
captured_address(23 downto 12); 
begin 

-- latch in address, and value of burst 
adreg: process (clk, rst) 

begin 
if rst = '1' then 

captured_address <= (others => '0'); 
captured_burst <= '0'; 

elsif clk'event and clk= '1' then 
if ads = '1' then 

captured_address <= address; 
captured_burst <= burst; 

end if; 
end if; 

end process; 

check address contents to see if memory access 
match <= '1' when captured_address(31 downto 24) = 

"00000000" else '0'; 

Warp User's Guide 



Synthesis 

-- DRAM address multiplexer 
mux: process (state, col_ad, row_ad) 

begin 
case state is 

when refad I wrl I wr2 => 
row col_address <= re_ad; 

when rasa I cas a I wl I w2 I w3 => 
row_col_address <= col_ad; 

when asdet => 
row_col_address <= row_ad ; 

when others => 
row_col_address <= (others => '-'); 

end case; 
end process; 

column address, Intel order 
col_ad(ll downto 2) <= captured_address(ll downto 2); 
col_ad(l) <= captured_address(l) xor burst_cnt(l); 
col_ad(O) <= captured_address(O) xor burst_cnt(O); 

Burst counter: 
bcount: process (clk, rst) 

begin 
if rst = '1' then 

burst_cnt <= "00"; 
elsif clk'event and clk = '1' then 

if state = idle then 
burst_cnt <= "00"; 

elsif state = w3 then 
burst_cnt <= burst_cnt + 1; 

end if; 
end if; 

end process; 
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-- DRAM refress request counter 
counter: process (clk, rst) 

begin 
if rst = '1' then 

count <= (others => '0'); 
elsif clk'event and clk = '1' then 

if ref = '1' then 
count <= (others => '0'); 

else 
count <= count + 1; 

end if; 
end if; 

end process; 
ref_req <= '1' when count = "101010101010101010101000" 

else '0'; 

-- DRAM state machine 
control: process (state, ref_req, match) 

begin 
case state is 

when idle => 
cas <= '1'; ras <= '1'; 
ack <= '1'; ref <= '0'; 

if ref_req = '1' then 
next_state <= ref ad; 

elsif ads = '1' then 
next_state <= asdet; 

end if; 

when asdet => 
cas <= '1'; ras <= '1'; 
ack <= '1'; ref <= '0'; 

if match = '1' then 
next_state <= rasa; 

else 
next_state <= idle; 

end if; 

when rasa => 
c'as <= '1'; ras <= '0'; 
ack <= '1'; ref <= '0'; 

next_state <= casa; 
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when casa => 
cas <= '0'; ras <= '0'; 
ack <= '1'; ref <= '0'; 

next state <= wi; 

when wi => 
cas <= '0'; ras <= '0'; 
ack <= '1'; ref <= '0'; 

next_state <= w2; 

when w2 => 
cas <= '0'; ras <= '0'; 
ack <= '1'; ref <= '0'; 

next_state <= w3; 

when w3 => 
cas <= '0'; ras <= '0'; 
ack <= '0'; ref <= '0'; 

Synthesis 

if (captured_burst = '1' and burst_cnt 1= ~11") 
then 

next_state <= nocas; 
else 

next_state <= idle; 
end if; 

when nocas => 
cas <= '1'; ras <= '0'; 
ack <= '1'; ref <= '0'; 

next_state <= casa; 

when refad => 
cas <= '1'; ras <= '0'; 
ack <= '1'; ref <= '1'; 

next_state <= wrl; 

when wrl => 
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ack <= '1'; ref <= '0'; 

next_state <= wr2; 
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when wr2 => 
cas <= '1'; ras <= '0'; 
ack <= '1'; ref <= '0'; 

next_state <= idle; 
end case; 

end process; 

clock state machine 
clocked: process (clk, rst) 

begin 
if rst = '1' then 

state <= idle; 
elsif clk'event and clk = '1' then 

state <= next_state; 
end if; 

end process; 

end controller; 

FPGA Optimization 

First Pass -- Default Options 

On the first pass through synthesis and the place and route tools, this example 
uses the default Galaxy options-buffer generation on, pad generation on, and 
speed optimization for inferred arithmetic components. In the synthesis report 
file, several operators are inferred: 

ex3.vhd (line 49, col 68): Note: Substituting module 
'warp_cmp_1s1c_ss' for '='. 

ex3.vhd (line 80, col 32): Note: Substituting module 
'warp_add_1s1c_ss' for '+'. 

ex3.vhd (line 94, col 24): Note: Substituting module 
'warp_add_1s1c_ss' for '+'. 

ex3.vhd (line 98, col 61): Note: Substituting module 
'warp_cmp_1s1c_ss' for '='. 

ex3.vhd (line 152, col 52): Note: Substituting module 
'warp_cmp_1s1c_ss' for '/='. 

The two 1/+" operators are used in counters. The 1/=" and" /=" operators are used 
for arithmetic comparisons. The following buffers and pads are inserted: 
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Begin PAD Generation. 

Created CLKPAD for signal 'clk' 
Above signal drives 63 Clocks, 0 Set/Resets. Total 

Created CLKPAD for signal 'rst' 
Above signal drives 0 Clocks, 63 Set/Resets. Total 

Created HD1PAD for signal 'ads' 
Above signal drives 0 Clocks, 0 Set/Resets, 34 other 

inputs. Total = 34 

Begin Buffer Generation. 

[max_ load = 7, fanout = 18J Created 2 buffers [DuplicateJ 
for 'MODULE _ 5_ sO _gl _ uO _c_ l' 

[max_ load = 7, fanout = 11J Created 1 buffers [DuplicateJ 
for 'MODULE _ 5_ sO _gl _ uO _c_ 2' 

[max_ load = 13, fanout 25J Created 1 buffers [DuplicateJ 
for 'ref OUT' -

[max_ load = 13, fanout 18J Created 2 buffers [Normal 
for 'stateSBV_2' 

r.-, 
63~ 
63 

Clock pads were automatically selected for the clock and reset signals because 
they fanout to all 63 of the flip-flops used. A high-drive pad, HDIPAD, was 
selected for signal ads because it has a large internal load. Buffers were created as 
well, per the defaults. The modules that were inferred have their own buffering 
requirements, and the remainder of the signals in the design are buffered if their 
loads are greater than 13, which is the default value of the max_load directive. 

The design is imported into SpDE for place and route. In the 
Tools->Options->General dialog box of SpDE, select the level 2 area optimization 
(L2 area) for technology mapping. Then run all the tools, record the logic cell 
utilization information from the In!o->Utilization information box, and gather the 
requisite timing information to calculate setup time (ts), clock to output time (teo) 
and maximum clock period (tscs) for internal operation (see Chapter 5, "SpDE," 
to calculate setup times, clock to output delays, and operating frequency). Next, 
choose level 2 speed (L2 speed) optimization and gather the same information. 
The results are summarized in Table 9-2. For each category (area, tSt tses, and 
teo), the best result is indicated by shading in the appropriate cell of the tableThe 
limiting factor for operating frequency is also listed. In this case, even though the 
design can be internally clocked for a clock period of tscs, the teo value is such 
that clocking at this interval would result in the outputs never being valid. 
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Table 9-2 First pass FPGA results 

L2 Area L2 Speed 

Area (logic cells) 108 116 

ts (ns) 14.4 14.9 

tscs (ns) 22.0 20.6 

teo (ns) 39.4 32.1 

limiting factor teo teo 

If the area and speed of this implementation are acceptable, then the job is done
the design does not need tuning. If, however, the user wishes to tune this design 
to improve either the area, speed, or both, then he must begin the tuning cycle. 
For the sake of continuing this example, assume that the user has not met his 
goals and first optimize this design for speed, then area. For speed improvement, 
the user wishes to decrease the setup time and clock to output delay. Assume that 
the user wants to run the design with a 40 ns clock period (25 MHz), with a 10 ns 
setup time and 30 ns clock to output delay. If the results were only a couple of 
nanoseconds from the desired goals, then the path analyzer in the place and route 
tool should be used to enter timing constraints. The place and route tool could 
then replace and reroute in an attempt to meet those constraints. For moderate 
improvement, returning to synthesis with directives is appropriate. If the user 
wanted to be significantly more aggressive with the clock to output delay, he 
would want to consider registering the outputs. The outputs are currently 
designed to be combinational outputs decoded from the current state of the state 
machine. Adding a pipeline for registering outputs is discussed in the chapter 
covering state machines in the VHDL text accompanying this documentation set. 
For this tutorial, the discussion will focus on using directives along with place 
and route constraints to meet the timing goals. 
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9.2.1.2 Second Pass-Speed Optimization (First Tuning Cycle) 

This begins the first tuning cycle. Look at Table 9-1 to determine which directives 
are applicable. The tscs goal has been achieved but not the ts or teo goal. The 
second pass will use two directives to influence the synthesis process and 
improve timing: (1) The pad generation directive is used to force ads to two high 
drive pads (HD2P AD). This is done to improve setup times. In FLASH370 CPLDs, 
delays are not dependent upon internal loading of signals. With the pASIC380 
FPGAs, delays are dependent upon fanout. A high drive pad increases the drive 
for the ads signal and reduce propagation delay. (2) The state_encoding 
directive is used to select one-hot encoding for the state machine. This is done to 
potentially improve the operating frequency and perhaps save logic cells. With 
sequential encoding, the 11 states of the state machine will require 4 state bits. 
With one-hot, 11 state bits will be required; however, with one-hot encoding, the 
next-state logic is simpler, so fewer overall logic cells (and fewer levels of logic 
cells) may be required. None of the other directives, including buffer_gen, will 
be used in this pass, to avoid introducing too many directives at the same time. 
Using too many directives at once limits the user's ability to determine which of 
them is helping or potentially hurting. Both attributes are placed directly in the 
code. The pad_gen attribute is placed in the entity declaration region, directly 
before the end statement. The state_encoding attribute is placed 
immediately after the type declaration. The attributes are: 

attribute pad_gen of ads:signal is pad_hd2; 
attribute state_encoding of states:type is one_hot_one; 

After synthesis, the report file indicates that one_hot_one encoding is used: 

State variable 'state' is represented by a Bit_vector 
(0 to 10). 

State encoding (one-hot one-state) for 'state' is: 
idle:= "10000000000"; 
asdet := "01000000000"; 
rasa:= "00100000000"; 
casa:= "00010000000"; 
w1.- "00001000000"; 
w2:= "00000100000"; 
w3:= "00000010000"; 
nocas .- "00000001000"; 
refad .- "00000000100"; 
wr1.- "00000000010"; 
wr2:= "00000000001"; 
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The report file also shows that ads is indeed using HD2PAD resources: 

Begin PAD Generation. 

Created CLKPAD for signal 'clk' 
Above signal drives 70 Clocks, 0 Set/Resets. Total 70 

Created CLKPAD for signal 'rst' 
Above signal drives 0 Clocks, 70 Set/Resets. Total 70 

Created HD2PAD for signal 'ads' 
Above signal drives 0 Clocks, 0 Set/Resets, 35 other 

inputs. Total = 35 
topld: ex4.vhd: Note: (N1347) When using multiple high

drive pads, manual pin assignment is suggested 

Begin Buffer Generation. 

[max_ load = 7, fanout = 18] Created 2 buffers [Duplicate] 
for 'MODULE_4_s0_g1_uO_c_l' 

[max_ load = 7, fanout = 11] Created 1 buffers [Duplicate] 
for 'MODULE_4_s0_g1_uO_c_ 2' 

[max_ load = 13, fanout 15] Created 2 buffers [Normal 
for 'stateSBV_ l' 

[max_ load = 13, fanout 28] Created 2 buffers [Normal 
for 'ref OUT' -

The results of the second pass as compared to the first pass are shown in 
Table 9-3, with the best results for each category highlighted. 

Table 9-3 Second pass FPGA results 

First Pass Second Pass 

L2 Area L2 Speed L2 Area L2 Speed 

Area (logic cells) 108 116 103 104 

ts (ns) 14.4 14.9 7.0 7.5 

tscs (ns) 22.0 20.6 19.8 18.5 

teo (ns) 39.4 32.1 29.8 26.2 

limiting factor teo teo teo teo 
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These results illustrate that using directives judiciously can significantly improve 9 
the design. The setup time improvement came from using two high drive pads (of 
course, using two pads will increase the load external to the device and should be 
considered for the overall system design). The area savings and tscs and teo 
improvements came from using one_hot_one encoding. 

9.2.1.3 Third Pass-Speed Optimization (Second Tuning Cycle) 

The design has now exceeded the stated goals; however, continue to optimize the 
design to see if additional directives bring any further advantages. Using the path 
analyzer in SpDE to examine the delays shows that the worst case clock to output 
path comes from decoding the state bits through the multiplexer to the output of 
row_address. Highlighting these paths shows that these signals must route long 
distances to several loads. In an attempt to minimize this delay, use the 
max_load to buffer aggressively these signals. Since these signals are created by 
the synthesis process, use the control file to add directives. VHDL attributes 
cannot be used to apply these directives because these signals are not currently in 
the VHDL source code. The attributes may be added if the source code is 
modified. VHDL will not allow the user to apply an attribute to an object that 
does not exist. In the control file, apply the directives to the names of the synthesis 
created signals from the report file and in the path analyzer. The signals are 
clearly generated from the state vector. To ensure that all state bits will be 
buffered as appropriate, use the "*,, wildcard to find all matches: 

attribute max_load of statesbv* is 5; 
attribute max_load of ref is 10; 
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The report file indicates proper buffering according to the control file: 

Begin Buffer Generation. 

[max_load = 7, fanout = 18] Created 2 buffers [Duplicate] 
for 'MODULE_5_s0_g1_uO_c_1' 

[max_load = 7, fanout = 11] Created 1 buffers [Duplicate] 
for 'MODULE_5_s0_g1_uO_c_2' 

Note: Using config. rule 'statesbv*' to set attribute 
'max_load' on 'stateSBV_O_BO'. 

Note: Using config. rule 'statesbv*' to set attribute 
'max_load' on 'stateSBV_O_B1'. 

[max_load = 5, fanout = 6] Created 2 buffers [Normal 
for 'stateSBV_O' 

Note: Using config. rule 'statesbv*' to set attribute 
'max_load' on 'stateSBV_1_BO'. 

Note: Using config. rule 'statesbv*' to set attribute 
'max_load' on 'stateSBV_1_B1'. 

Note: Using config. rule 'statesbv*' to set attribute 
'max_load' on 'stateSBV_1_B2'. 

[max_load = 5, fanout = 15] Created 3 buffers [Normal 
for 'stateSBV_1' 

[max_load = 10, fanout 
for 'ref_OUT' 

28] Created 3 buffers [Normal 

The results after place and route are only marginally better. The user is 
approaching the best implementation possible. To improve upon this 
implementation, the user could try adjusting the max_load to be slightly less 
aggressive. Being too aggressive may cause too many buffers to be inserted. The 
user may also iterate with the timing driven place and route tools by entering 
constraints via the path analyzer. See Chapter 5, "SpDE," to learn how to do this. 

The summarized results of the speed optimization passes are shown in Table 9-4, 
highlighting the implementation that gave the best result in a given category. 
Because the limiting factor is,teo, the results of L2 Area in the third pass work 
best. Next, optimize the design for area where the results may be surprising 
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Table 9-4 Third pass FPGA results 

First Pass Second Pass Third Pass 

L2 L2 L2 L2 L2 L2 
Area Speed Area Speed Area Speed 

Area (logic cells) 108 116 103 104 103 104 

ts (ns) 14.4 14.9 7.0 7.5 7.2 7.1 

tscs (ns) 22.0 20.6 19.8 18.5 18.0 18.4 

teo (ns) 39.4 32.1 29.8 26.2 26.0 26.6 

limiting factor teo teo teo teo teo teo 

Fourth Pass-Area Optimization 

Up to this point, this example has assumed that the target device is a CY7C384A, 
a 2K gate device. Because only slightly more than half the resources of this device 
(from 104 to 116 of the 192 available logic cells) are being used, it may be 
worthwhile to optimize the design for area to see if it will fit in the CY7C382A, a 
1K gate device with 96 logic cells. For this optimization, leave the pad_gan and 
ona_hot attribute from the first tuning cycle, but remove the buffer generation 
of the subsequent cycle. In addition, change the synthesis goal in the Galaxy 
menu from speed to area, and resynthesize the design. The results are excellent 
(see Table 9-5) 

Warp User's Guide 331 



Synthesis 

9.2.2 

9.2.2.1 

332 

Table 9-5 Fourth pass FPGA results 

First Pass Second Pass Third Pass Fourth Pass 

L2 L2 L2 L2 L2 L2 L2 L2 
Area Speed Area Speed Area Speed Area Speed 

Area 
(logic 108 116 103 104 103 104 91 92 
cells) 

ts (ns) 14.4 14.9 7.0 7.5 7.2 7.1 5.8 5.5 

tscs (ns) 22.0 20.6 19.8 18.5 18.0 18.4 22.2 22.2 

teo (ns) 39.4 32.1 29.8 26.2 26.0 26.6 26.0 26.8 

limiting 
teo teo teo teo teo teo teo teo factor 

The design fits in the 1K gate device and achieves the original timing goals. In 
fact, they are superior in some respects to the ones that were achieved with the 2K 
gate device. This is not surprising because the 1K gate device is smaller. Thus, 
signals route smaller distances. At this point the user is finished-he has fit the 
design into the smallest FPGA while meeting the timing goals. 

Next, the example will fit this design into a FLASH370 CPLD. 

CPLD Optimization 

First Pass 

On this first pass, use the default synthesis and fitting options which yield the 
results summarized in Table 9-6. The "L2 Area" and "L2 Speed" columns have 
been removed because a fitter for CPLDs is used instead of the SpDE place and 
route tool. 
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Table 9-6 First pass CPLD results 

First Pass (default) 

Macrocells 79 

Product terms 225 

ts (ns) 6.0 

tscs (ns) 10.0 

teo (ns) 16.0 

limiting factor teo 

This design requires a 128 macrocell member of the FLASH370 family of CPLDs. 
Not surprisingly, it has excellent speed. This is because the design is essentially a 
state machine, counters, and a little bit of combinational logic. This 
implementation has far superior performance over the FPGA, but it also requires 
a larger device. In the FPGA, however, if an additional pipeline were added to 
improve clock to output delays (the limiting factor in this design), then system 
speeds could approach 50 MHz. The additional pipeline would require a 2K 
device, resulting in different performance numbers. 

A tuning cycle will not likely improve upon the speed and area of this CPLD 
implementation for two reasons: (1) The area versions of the counters will require 
just as many macrocells and product terms as the speed versions. This is because 
this counter is implemented very efficiently using T -type flip-flops. (2) Using the 
state_encoding attribute with the one_hot_one value will neither increase 
performance (it is already at its maximum-one pass through the logic array) nor 
reduce the number of required macrocells. In fact, a one-hot implementation 
will require more macrocells. It may reduce the number of product terms, but the 
current implementation uses only 35% of the available product terms. Gray 
encoding will require the same nUmber of macrocells, but could possibly require 
fewer product terms. So, even though the current implementation is satisfactory, 
resynthesize and fit the design using the "gray" value for the sta te_encoding 
directive. 
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This pass implements the state_encoding directive with a VHDL attribute 
placed in the architecture body declarative region where the state type is 
declared: 

attribute state_encoding of states:type is gray; 

Warp reports the following fitter error: 

Error: Signal stateSBV_3 uses too many input 
signals, (logic+OE+AR+AP) . 

This error indicates that one of the state bits requires more than the 36 inputs. The 
FLASH370 allows only 36 inputs into a given logic block (no other CPLD has 
more). Examine the report file to find the equation that verifies the veracity of this 
error message and to see what can be done to correct it. The equation is as follows: 

IstateSBV_3.D = 
/stateSBV_O.Q * IstateSBV_3.Q * IstateSBV_2.Q * 
Icount_2.Q * Icount_l.Q * Icount_O.Q * count_5.Q * 
Icount_4.Q * count_3.Q * Icount_B.Q * count_7.Q * 
Icount_6.Q * count_ll.Q * Icount_10.Q * count_9.Q * 
Icount_14.Q * count_13.Q * Icount_12.Q * 
count_17.Q * Icount_16.Q * count_15.Q * 
Icount_20.Q * count_19.Q * Icount_18.Q * 
count_23.Q * /count_22.Q * count_21.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_31.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_30.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_29.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_28.Q 

+ IstateSBV_O.Q * stateSBv_3.Q * IstateSBV_2.Q * 
captured_address_27.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_26.Q 

+ IstateSBV_O.Q * IstateSBV_3.Q * IstateSBV_2.Q * 
lads 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_25.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
captured_address_24.Q 

+ IstateSBV_O.Q * stateSBV_l.Q * IstateSBV_2.Q 
+ IstateSBV_l.Q * stateSBV_2.Q 
+ stateSBV_O.Q * stateSBV_2.Q 
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Here, notice that the equation for this state-bit requires all inputs of the counter. B 
This is due to the state transition out of the idle state when ref_req is asserted. In • 
addition, notice that capt ured_addres s is required. This is due to the state 
transitions out of the asdet state when match is asserted. In the sequential 
encoding, the third bit of the state vector does not require all of these inputs: the 
capture_address inputs are used with a different state bit. To avoid this problem, 
this equation must be factored. A natural point to break this equation is with the 
captured_address signals or counter signals. The user can create a factoring point 
by applying the synthesis_off directive to either the match signal or the 
reLreq signal (or both). The next pass will show how to create one with the match 
signal. Creating this break-point will require a second pass through the logic 
array. This will result in additional delay and require additional resources. 
Obviously, the implementation will be inferior to the one achieved in the first 
pass. Nonetheless, this example will show how to work around this problem for 
instructional purposes. After all, it would be nice to know how to get around a 
problem like this one, if the user encountered' it in the first pass. 

It is interesting to note that the state encoding affected the number of terms in an 
equation. 

Third Pass -- Synthesis_off 

The synthesis_off directive is applied with a VHDL attribute, placed in the 
architecture declarative region where the match signal is declared: 

attribute synthesis_off of match:signal is true; 

The design fits. The report file indicates that gray encoding is used: 

State variable 'state' is represented by a Bit_vector 
(0 to 3) . 

State encoding (gray) for 'state' is: 
cas a := "0010"; 
idle:= "0000"; 
asdet := "0001"; 
rasa:= "0011"; 
cas a := "0010"; 
w1.- "0110"; 
w2 : = " 0111" ; 
w3 : = " 0101" ; 
nocas .- "0100"; 
refad .- "1100"; 
wr1 .
wr2 := 

"1101"; 
"1111"; 
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The equations also show that match was used as a factoring point: 

IstateSBV_3.D = 
IstateSBV_O.Q * IstateSBV_3.Q * IstateSBV_2.Q * 
Icount_2.Q * Icount_l.Q * Icount_O.Q * count_5.Q * 
Icount_4.Q * count_3.Q * Icount_B.Q * count_7.Q * 
Icount_6.Q * count_ll.Q * Icount_10.Q * count_9.Q * 
Icount_14.Q * count_13.Q * Icount_12.Q * 
count_17.Q * Icount_16.Q * count_15.Q * 
Icount_20.Q * count_19.Q * Icount_1B.Q * 
count_23.Q * Icount_22.Q * count_21.Q 

+ IstateSBV_O.Q * stateSBV_3.Q * IstateSBV_2.Q * 
Imatch.CMB 

+ IstateSBV_O.Q * IstateSBV_3.Q * IstateSBV_2.Q * 
lads 

+ IstateSBV_O.Q * stateSBV_l.Q * IstateSBV_2.Q 
+ IstateSBV_l.Q * stateSBV_2.Q 
+ stateSBV_O.Q * stateSBV_2.Q 

match 
Icaptured_address_31.Q * Icaptured_address_30.Q * 
Icaptured_address_29.Q * Icaptured_address_27.Q * 
Icaptured_address_26.Q * Icaptured_address_25.Q * 
Icaptured_address_24.Q * Icaptured_address_2B.Q 

The area and speed results are summarized in Table 9-7. This implementation 
requires fewer product terms, but has slower performance than the first 
implementation. 

Table 9-7 Third pass CPLD results 

First Pass Second Pass Third Pass 
(Defaults) (Gray Encode) (Synthesis_off) 

Macrocells 79 Fit Error 80 

Product terms 225 Fit Error 202 

ts (ns) 6.0 Fit Error 6.0 

tscs (ns) 10.0 Fit Error 19.0 

teo (ns) 16.0 Fit Error 16.0 

limiting factor teo Fit Error tscs 
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Either of the successful CPLD implementations provide superior speed over the 
FPGA implementation, but they also require a larger density device. The next 
example selects a design that favors FPGAs for speed and area. 

9.3 Example 2-Multiply and Accumulate Function 

9.3.1 

The code of the following listing is a multiply and accumulate design. Once again, 
this design will be optimized first for a pASIC380 FPGA, then for a FLASH370 
CPLD. 

library ieee; 
use ieee.std_logic_1164.all; 

entity math is port ( 
clk, rst, mac:std_logic; 
a, b:in std_logic_vector(7 downto 0); 
q: buffer std_logic_vector(lS downto 0»; 

end math; 

use work.std_arith.all; 
architecture math of math is 
begin 
p1: process (rst, clk) 

begin 
if rst = '1' then 

q <= (others => '0'); 
elsif clk'event and clk='l' then 

q <= (a * b) + q; 
end if; 

end process; 
end math; 

FPGA Optimization 
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First Pass -- Default Options 

In the first pass through the design, use the default Galaxy options-buffer 
generation on, pad generation on, and speed optimization for inferred arithmetic 
components. In the report file, the two arithmetic operators are inferred: 

g.vhd (line 18, col 16): Note: Substituting module 
'warp_mul_2s_ss' for '*'. 

g.vhd (line 18, col 21): Note: Substituting module 
'warp_add_2s_ss' for '+'. 

The signals elk and r s t were placed on clock pads. Some of the inputs were 
also selected for high drive pads because of high internal fanout. The default 
value for the rnax_l oad directive is 13, so the following buffers were inserted: 

Begin PAD Generation. 

Created CLKPAD for signal 'clk' 
Above signal drives 16 Clocks, a Set/Resets. Total 16 

Created CLKPAD for signal 'rst' 
Above signal drives a Clocks, 16 Set/Resets. Total 16 

Created HDIPAD for signal 'b_l' 
Above signal drives a Clocks, a Set/Resets, 16 other 
inputs. Total = 16 

Created HDIPAD for signal 'a_I' 
Above signal drives a Clocks, a Set/Resets, 16 other 
inputs. Total = 16 

Created HDIPAD for signal 'a_2' 
Above signal drives a Clocks, a Set/Resets, 16 other 
inputs. Total = 16 

Created HDIPAD for signal 'a_3' 
Above signal drives a Clocks, a Set/Resets, 16 other 
inputs. Total = 16 
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----------------------------------------------------------
Begin Buffer Generation. 
----------------------------------------------------------
[max load = 13, fanout 15] Created 2 buffers [Normal 

for 'a _0_ IN' 
[max_ load = 13, fanout 15] Created 2 buffers [Normal 

for 'b _0_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'a _4_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'a _S_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'a _6_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'a _7_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'b _2_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'b _3_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'b _4_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'b_5_ IN' 
[max_ load = 13, fanout 16] Created 2 buffers [Normal 

for 'b_6_ IN' 
[max_ load = 13, fanout 16 ] Created 2 buffers [Normal 

for 'b _7_ IN' 

The area and speed results are listed in Table 9-8. This time, setup times are the 
limiting factor. That is, the design cannot be clocked at tscs because that would 
violate setup times. 

Table 9-8 First pass FPGA results 

L2Area L2 Speed 

Area 163 186 

is (ns) 68.8 73.9 

iscs (ns) 22.8 24.9 

teo (ns) 11.3 IDA 

limiting factor is ts 
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If the user wanted to pursue a faster design, then he could experiment with the 
max_load directive as well as the 5pDE timing driven place and route to 
minimize the delays of particular paths. Going through this process may yield a 
small improvement over the current speed numbers. 

Second Pass-Area Optimization 

Because the default options use speed optimization, rerun the design with area 
optimization on. After synthesis and place and route, the results are exactly the 
same as in the first pass. This is because the adder and multiplier modules for the 
widths used in this design have the same implementation for both speed and area 
optimized versions. 

Next, this design will be implemented in a FLASH370 CPLD. 

CPLD Optimization 

First Pass -- Default Options 

Once again, the first pass will use the default Galaxy options. This means speed 
optimization. With these options, the design will not fit (fable 9-9) because it 
requires too many macrocells. It also requires nearly all of the available product 
terms. So, pursue area optimization. 

Table 9-9 First pass CPLD results 

First Pass (Defaults) 

Macrocells 132 

Product terms 620 

ts (ns) N/A 

tscs (ns) N/A 

teo (ns) N/A 

limiting factor did not fit 
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9.3.2.2 Second Pass -- Area Optimization 

The results of area optimization are summarized in Table 9-10: 

Table 9-10 Second pass CPLD results 

First Pass (Defaults) Second Pass (Area) 

Macrocells 132 120 

Product terms 620 605 

ts (ns) N/A 87.0 

tscs (ns) N/A 66.0 

teo (ns) N/A 7.0 

limiting factor did not fit ts 

The setup time for this combination of operations-multiply and accumulate-is 
the limiting factor for the maximum frequency of this design. 

For this application, the FPGA performed better and required fewer resources. 
This is not surprising. FPGAs often do well in datapath and register-intensive 
applications. 

Now each of the directives listed in Table 9-10 will be covered topically by the 
categories listed in the columns-area optimization, speed optimization, specific 
control, documentation/ selection. 

9.4 Area Optimization 

9.4.1 

This section describes the directives and techniques required to successfully 
implement a logic design with the minimum device resources (minimum area) 
being utilized. The techniques are often different for FPGA and CPLD 
architectures. The focus of this section is to provide recommended techniques for 
area optimization based on device architecture. 

CPLD and FPGA Considerations 

This section discusses area optimization methods relating to all Cypress 
programmable devices. The goal, synthesis_off, and no_factor 
directives are discussed. 
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attribute goal of architecture_name architecture is area; 

or command line option: -yga 

The goal value of area indicates that all modules inferred from VHDL operators 
will be optimized for area. The Warp synthesizer will select an implementation 
that is optimized to use the minimum device resources. A 16-bit adder example 
with the goal directive placed on an architecture is shown below. This code will 
generate a ripple carry adder with a 2-bit group as the basic unit. This adder 
would be implemented as carry-look-ahead if the goal was set to speed. A 
comparison of the results after compilation for each goal and target device type is 
shown in Table 9-11. 

Table 9-11 Results of GOAL directives 

FPGA CPLD 

Area Opt. Speed Opt. Area Opt. Speed Opt. 

24 logic cells 45 logic cells 23 macrocells 35 macro cells 

8 passes 4 passes 8 passes 3 passes 

library ieee; 
use ieee.std_logic_1164.all; 
use work.std_arith.all; 
entity add16_a is porte 

a, b:in std_logic_vector (15 downto 0); 
sum:out std_logic_vector (15 downto 0»; 

end add16_a; 

architecture archadd16_a of add16_a is 
ATTRIBUTE goal OF archadd16_a : ARCHITECTURE IS area; 
begin 

sum <= a + b; 
end; 
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9.4.1.2 The SYNTHESIS_OFF Directive 

ATTRIBUTE synthesis_off OF signal_Dame : signal IS true; 

When the synthesis_off directive is set to true, a signal is made into a 
factoring point for logic equations. This directive keeps the signal from being 
substituted out during the optimization process. The node number is used to 
reference a macrocell within a CPLD. 

Synthesis_off is useful for the following reasons: 

• It gives the user control over which equations or sub-expressions need to 
be factored into a node. 

• It provides better results for designs where a signal with a large 
functionality is being used by many other signals. If left alone, the fitter 
would collapse all the internal signals (which is desirable in many cases) 
and may drive the design's resource requirements beyond the available 
limits. 

• It helps in cutting down on compile time for designs which have a lot of 
lisignal redirection" (signals getting inverted or reassigned to other 
signals). This directive provides the logic optimizer a better control over 
the optimization process, by reducing the number of signals it needs to 
deal with. 

By using the synthesis_off directive, the user can assign the commonly used 
signal to a node and bring down the resource utilization. 

A side effect of using the synthesis_off directive is that the design will now 
take an extra pass through the array to achieve the same functionality. The extra 
pass may be required anyway, if more than 16 PTs are required. 

This directive is recommended only on combinatorial signals. Registered signals 
are assigned to a node by natural factoring, and the synthesis_off directive 
on these signals is redundant. 

This directive can be associated with signals declared both in VHDL and 
schematics. The BUF component can also be used in schematics and VHDL to 
achieve the same results as the synthesis_off directive. Please refer to the 
Warp Synthesis manual for more details. 
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This directive allows the designer to force multiple passes through logic cells for 
optimal density. The following example uses the synthesis_off directive and 
uses 30 Macrocells in a CY7C371. This same design requires 43 Macrocells in a 
CY7C371 without using the synthesis_off directive: 

library ieee; 
use ieee.std_logic_1164.all; 
use work.std_arith.all; 

entity cpldadd is port( 
a: in std_logic_vector(7 downto 0); 
b: in std_logic_vector(7 downto 0); 
c: in std_logic_vector(7 downto 0); 
sum: out std_logic_vector(7 downto 0»; 

end cpldadd; 

architecture areacpldadd of cpldadd is 
signal intsum: std_logic_vector(7 downto 0); 
attribute synthesis_off of intsum:signal is true; 

begin 

intsum <= a + b; 
sum <= intsum + c; 

end areacpldadd; 

The NO_FACTOR Directive 

ATTRIBUTE no_factor OF signal_Dame : signal IS false; 

The no_factor directive when set to true prevents logic factoring within the 
Warp synthesis engine. This means that factors which can be shared among 
multiple outputs are not generated. For area optimization, the no_factor 
directive should always be set to false. This allows the synthesizer to create 
common logic that can be shared, thus reducing the resources required. 

FPGA Considerations 

This section discusses area optimization methods using the Cypress pASIC380 
FPGA architecture. The state_encoding and buffer_gen directives are 
discussed. 
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The STATE_ENCODING Directive 

The state_encoding directive specifies the internal encoding scheme for 
values of an enumerated type. For most state machine designs larger than 4 states, 
the values recommended for area optimization in FPGAs are either 
one_hot_one or one_hot_zero. The choice of which type to use depends on 
the design being implemented. A detailed description of each encoding value is 
provided below. Further information on state encoding schemes may be found in 
the VHDL textbook accompanying this document set. 

ATTRXBUTE state_encoding OF type_name : type XS 
one_hot_zero; 

When the state_encoding value is set to one_hot_zero, the encoding of 
the first value in the type definition is set to o. Each succeeding value in the type 
definition has its own bit position (flip-flop) in the encoding sequence. Thus, a 
one_hot_zero encoding of an enumerated type with N possible values 
requires N-l bits (flip-flops). The following VHDL code will generate a 
one_hot_zero state machine design: 

This state machine implements a simple traffic light. 
The N - S light is usually green, and remains green 
for a minimum of five clocks after being red. Xf a 
car is travelling E-W, the E-W light turns green for 
only one clock. 

PACKAGE DesgnPkg XS 
TYPE state XS (green_red, yellow_red, red_green, 

red-yellow) ; 
ATTRXBUTE state_encoding OF state: type XS one_hot_zero; 
END DesgnPkg; 

library ieee; 
use ieee.std_logic_1164.all; 
use work.desgnpkg.all; 

ENTXTY traffic_light XS 
PORT (clk, car: XN.STD_LOGXC;--E-W travelling car 

lights: BUFFER state); 
END traffic_light; 

ARCHXTECTORE moorel OF traffic_light xs 
The lights (outputs) are encoded in the following 
states. For example, the state green_red indicates 
the N-S light is green and the E-W light is red. 
nscount is used to verify five consecutive N-S greens 
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SZGNAL nscount: ZNTEGER RANGE 0 TO 5; 
BEGZN 

PROCESS 
BEGZN 

WAZT ONTZL elk = 111; 
CASE lights ZS 

WHEN green_red => 
ZF nscount < 5 THEN 

lights <= green_red; 
nscount <= nscount + 1; 

ELSZF car = 111 THEN 
lights <= yellow_red; 
nscount <= 0; 

ELSE 
lights <= green_red; 

END ZF; 
WHEN yellow_red => lights <= red_green; 
WHEN red_green => 

lights <= red-yellow; 
WHEN red-yellow => lights <= green_red; 
WHEN others => lights <= green_red; 

END CASE; 
END PROCESS; 

END moore1; 

The resulting state bit assignments indicated in the report file file-name.rpt for the 
one_hot_zero design is shown below: 

State variable 
(0 to 3) . 

State encoding 
green_red 
yellow_red 
red_green 
red_yellow 

'lights' is represented by a Bit_vector 

(one-hot zero-state) for 'lights' is: 
:="000"; 
:="100"; 
:="010"; 
:="001"; 

ATTRZBUTE state_encoding OF type_name : type ZS one_hot_one; 

One_hot_one state encoding is similar to one_hot_zero, except that zero 
encoding is not used. Every state value has a bit position that is set to "1" when 
the state variable is active. Thus, a one_hot_one encoding of a state machine 
with N possible values requires N bits (flip-flops). 

If the package statement used for the one_hot_zero street light example above 
is changed to use one_hot_one, then the package declaration would appear as 
shown: 
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PACKAGE DesgnPkg XS 
TYPE state XS (green_red, yellow_red, red_green, 

red-yellow) ; 
ATTRXBUTE state_encoding OF state: type XS 

one_hot_zero; 
END DesgnPkg; 

The resulting state bit assignments indicated in the report file vhdlJile.rpt for the 
one_hot one is shown below: 

9.4.2.2 

State variable 'lights' is represented by a Bit_vector 
(0 to 3) . 

State encoding 
green_red 
yellow_red 
red_green 
red_yellow 

(one-hot one-state) for 'lights' is: 
:="1000"; 
:="0100"; 
:="0010"; 
:="0001"; 

Notice that the one_hot_one design uses an extra flip-flop for the first state 
assignment compared to the one_hot_zero implementation. 

This traffic light example takes six logic cells when implemented in a CY7C381A 
using one_hot_zero and seven logic cells when using one_hot_one. This 
ratio may not always be the same, depending on other specifics on how the 
design is implemented. A one_hot_zero implementation is useful in situations 
where only a reset is available to the registers in a PLD. If an asynchronous signal 
is required for initialization of the registers in a 22vlO, then a reset is the only 
option. In this case, use a one_hot_zero state machine for initialization to state 
zero. The one_hot_zero may be less optimum if the Idle state (all Os) is 
required to decode an output signal or multiple transitions to different states. In 
this case, all the state bits would have to be decoded to verify that the machine is 
in Idle. 

In general, one - hot designs are faster than binary encoded because state 
transition decodings are simple. For FPGA architectures, a flip-flop is a less vital 
resource than product term inputs because of the finer grain logic implementation 
with a flip-flop in every cell. For these reasons it makes sense to use the one-hot 
technique for FPGA state machines. This is not necessarily true for CPLD state 
machine designs. 
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The BUFFER_GEN Directive 

signal ZS buf_none; 

orconunandlineoption:-yb 

The buf fer _gen directive controls the buffering strategy for signals that have a 
high fanout (exceeding max_load). If a signal has a high fanout, then signal 
propagation delays increase significantly. The buffer_gen value is by default 
bUf_auto. The buf_none value is preferred for least resources being used. 
Buffer generation should only be used where speed is of concern. Refer to Section 
9.6.2, "Speed Optimization for FPGAs" for further details on buffer_Slen. 

CPLD Considerations 

This section discusses area optimization methods using all Cypress PLD and 
CPLD architectures. The ff_type directive applies to area optimization in 
CPLDs. 

The FF _ TYPE Directive 

signal IS ff_opt; 

or conunand line option: - f 0 

The ff_type value of ff_opt tells Warp to synthesize the signaCname to the 
optimum flip-flop type for the logic implemented. A flip-flop is chosen based on 
the fewest resources required to implement the logic function. For instance, a D
type flip-flop may be chosen for register data storage functions, while aT-type 
(toggle) flip-flop may be chosen for counters. This option is recommended for all 
designs unless the designer has specific requirements to force the use of a 
different flip-flop. 

9.5 Specific Control 

This section describes specific control features of the Warp synthesis tool. 
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The FF _ TYPE Directive (CPLD Only) 

ATTRIBUTE ff_type OF signal_name : signal IS ff_d; 

or command line option: - f d 

The ff_type value of ff_d tells Warp to synthesize the signaCname using a D
type flip-flop. This will force the synthesizer to use a D-type flip-flop to generate 
signaCname. This directive will typically only be used if the Warp synthesis tool is 
not using the D-type flip-flop where the designer intends. 

or command line option: - f t 

The ff_type value of ff_t tells Warp to synthesize the signal_name using a 
T-type flip-flop. This will force the synthesizer to use a toggle flip-flop to generate 
signal_name. This directive will typically only be used if the Warp synthesis 
tool is not using a toggle flip-flop, which the designer intends for functional 
reasons. 

The FIXED_FF Directive (FPGA Only) 

ATTRIBUTE fixed_ff of signal_name : signal is 
register_location 

or command line option: - f n [n=register location] 

The fixed_ff directive locks a flip-flop to a specific cell location in the device. 
This directive overrides the default placement that the SpDE placer assigns 
automatically. The f ixed_f f directive is applied to the Q output signal of a flip
flop. If the fixed_ff directive is aSSigned to any other signal besides the Q 
output of a flip-flop, the directive is ignored. An example follows: 

library ieee; 
use ieee.std_logic_1164.all; 

ENTITY ff_type_test IS 
PORT (clk, ff_D: IN STD_LOGIC; -- Flip-flop clock, D-input 

ff_Q: OUT STD_LOGIC); -- Flip-flop Q output 
ATTRIBUTE fixed_ff OF ff_Q:signal IS "Al"; 

END ff_type_test; 
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BEGIN 
PROCESS 
BEGIN 

WAIT UNTIL clk = Ill; 
ff_Q <= ff_D; -- Generate output 

END PROCESS; 
END arch_ff_type_test; 

The above code segment will ensure the signal f f_Q is generated from the flip
flop located in cell" AI" of a pASIC device. This allows the designer to manually 
place flip-flops to override the SpDE floor planner. This directive is used to place 
flip-flops in close proximity in order to reduce routing lengths for critical path 
signals. Flip-flops may be grouped together to provide maximum operating 
speed. Refer to Section 9.6.2, "Speed Optimization for FPGAs," for further details 
on optimizing a design for speed using the f ixed_f f directive. 

The NODE_NUM Directive (PLD & CPLD Only) 

ATTRIBUTE Dode_Dum OF signal_name : signal IS iDteger ; 

or command line option: -fn [n=node location] 

The Dode_Dum directive locks a Signal to a specific location in the target device. 
This directive overrides the default placement that the Warp tool would assign 
automatically. This directive applies to any combinatorial or sequential node 
within the design. 

Example: 

library ieee; 
use ieee.std_Iogic_1164.all; 

ENTITY Dode_Dum_test IS 
PORT (elk, ff_D: IN STD_LOGIC; -- Flip-flop clock, D-iDput 

ff_Q: OUT STD_LOGIC); -- Flip-flop Q output 
ATTRIBUTE Dode_num OF ff_Q:SIGNAL IS 398; 

END Dode_Dum_test; 

ARCHITECTURE arch_node_Dum test OF node_Dum_test IS 
BEGIN 

PROCESS 
BEGIN 

WAIT UNTIL clk = Ill; 
ff_Q <= ff_D; Generate output 

END PROCESS; 
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The above code segment will ensure the signal f f_Q is generated from the 
macro cell driving node 398 in a CY7C374 device. Node 398 refers to buried 
macro cell A in logic block #1 in a CY7C374. The specific node numbers available 
for each FLASH370 series device may be found in the Reference Manual . 
accompanying this document set. This directive allows the designer to manually 
place logic to override the Warp floor planner. 

The LAB_FORCE Directive (CPLD Only) 

ATTR1:BUTE lab_force OF signal_nlilJDe : signal 1:S "string"; 

The lab_force directive aids in grouping signals together as a requirement to 
the fitter. The string contains the name of the logic block. This directive will 
force signa l_name to the string internal logic block without regard for 1/0 
pin assignments. In most designs, the automatic assignment by the fitter is 
acceptable. In some cases, the user may want to constrain the fitter to obtain better 
partitioning than can be performed automatically. This directive should only be 
used if the user is intimately familiar with the target CPLD architecture. This 
directive can cause routing difficulties if logic is placed in an area that can block 
routing paths. 

Example: 

ATTRIBUTE lab_force OF ff_Q:S1:GNAL 1:8 "B2"; 

This will force the signal ff_Q to the lower half of logic block B in a FLASH370 
device. In the following example: 

ATTR1:BUTE lab_force OF ff_Q:signal 1:8 "Bl"; 

The signal f f_Q is forced to the upper half of logic block B. 
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The SUM_SPLIT Directive (CPLD Only) 

ATTR~BUTE sum_split OF signal_name : signal ~s value; 

The sum_spli t value can be balanced or cascaded. The default value is 
balanced. Use the balanced value if reliable balanced timing is desired at the 
expense of area. The following figure describes the balanced sum split concept: 

ATTR~BUTE sum_split OF sum_signal:sig.nal ~s balanced; 

Figure 9-2 The balanced sum split concept 

The cascaded method uses only two macrocells to implement an equation. 
There is no control over which product term is assigned to which macrocell. The 
signals that are not split into macrocell #1 will arrive at macrocell #2 sooner, 
thereby making the timing for the outputs different based on different arrival 
times. If these output signals are registered, then of course the timing generated at 
the outputs are the same. 

ATTR~BUTE sum_split OF sum_signal:signal ~s cascaded; 
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Which sum_split method to use depends on the area constraints and how the 
design is implemented. Use the balanced method first and then the cascaded, if 
the design did not fit using balanced. 

The POLARITY Directive (CPLD Only) 

ATTRIBUTE polarity OF signal_name : signal IS value; 

The polari ty directive is used to select polarity for signals in a design. There are 
two options for polarity, pl_keep and pl_opt. The pl_keep option will 
instruct the Warp compiler to keep the polarity of a signal as currently specified in 
the design. The pl_keep option is useful to instruct the compiler about the 
desirable output sense of a signal at power up. When a circuit is initialized, it may 
be desirable to provide an output as a 1/1" or I/O" and maintain this condition 
without the compiler changing the sense for optimization reasons. In another 
case, it may be desirable to keep signal senses in order to debug designs in the 
simulator without being concerned about compiler-induced internal inversions. 
In most cases, however, the pl_opt is the best choice. This option allows the 
compiler to change the sense of internal Signals to provide the best optimization 
for a design. 
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This section describes the synthesis directives and techniques that may be used in 
optimizing a design for performance. In most cases, the techniques for speed 
optimization are device dependent. The discussion will cover first those 
directives applicable to both FPGAs and CPLDs, then those for FPGAs only. 

Speed Optimization for both FPGAs and CPLDs 

The GOAL Directive 

ATTRIBUTE goal OF architecture_name: architecture IS speed; 

The goal value of speed indicates that all arithmetic modules inferred from 
VHDL operators will be optimized for speed. The Warp synthesizer will select an 
implementation that is optimized to achieve the best performance. This is a good 
first step to take when optimizing a design for performance. To demonstrate the 
goal directive, observe the performance delta in the following 8-bit adder 
example implemented in a FLASH370 CPLD: 

library ieee; 
use ieee.std_10gic_1164.a11; 
use work.std_arith.a11; 

entity add8_a is port( 
a, b: in std_10gic_vector (7 downto 0); 
sum: out std_10gic_vector (7 downto 0»; 

end add8_a; 

architecture archadd8 a of add8 a is 
attribute goal of archadd8_a: architecture is speed; 
begin 

sum <= a + b; 
end; 

Results with goal set to area was 57.0 ns (17.5 Mhz) worst case delay. 

Results with goal set to speed was 27.0 ns (37 Mhz) worst case delay. 
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9.6.1.2 The DONT _TOUCH Directive 

9.6.2 

9.6.2.1 

ATTRIBUTE dont_touch OF label_name: label IS true; 
ATTRIBUTE dont_touch OF entity_name: entity IS true; 

In some rare cases, a block of a design may need to be hand-optimized. The user 
may instruct Warp to leave the individually optimized block alone by applying 
the dont_touch directive to the entity or the component to prevent any 
optimization on the block. Under most circumstances, this directive is not needed 
since Warp's optimization usually improves performance and resource efficiency. 

architecture arch~accumulator of accumulator is 

attribute dont_touch of blockl: label is true; 

begin 
blockl: add' (a, b, sum); 

OR 

entity my_adderS is port ( 
a,b: in std_logic_vector(O to 7); 

) ; 
attribute dont_touch of my_adderS: entity is true; 

end entity my_adderS; 

Speed Optimization for FPGAs 

The BUFFER_GEN and the MAX_LOAD Directives 

ATTRIBUTE buffer_gen OF signal_name: signal IS value; 
ATTRIBUTE max_load OF signal_name: signal IS integer; 

Buffering a signal with high fanout effectively reduces the load seen by a signal, 
and is used to reduce the propagation delay of that signal. Warp is capable of 
implementing several methods of buffering. By default, Warp attempts automatic 
buffering (buf_auto, explained below). If a different buffering technique is 
desired for a particular signal, or register duplication is required, then the 
buffer_gen directive may be applied to that signal. To specify a limit on the 
number of loads a signal should have, the max_load directive may be used in 
conjunction with the buffer_gen directive. When Warp encounters a signal 
with a fanout count larger than the specified max_load value, it buffers the 
signal. Warp has a default maximum load setting of 13. 
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Buffer generation options are: 

buf_none: When the buf_gen directive is set to this value, Warp will not buffer 
this signal. It prevents resources from being used unnecessarily as buffers. This 
value should be used for signals which are not timing critical. 

buf_auto : This is the default setting Warp uses for buffer generation. With this 
setting, Warp first attempts buf_duplicate, then attempts buf_normal. The 
buf_register will not be attempted. 

buf_normal : A buffer tree is created between the signal source and its loads 
until every node has a fanout of less than the maximum load count as specified by 
the max_load directive. This technique is best used for signals that have very high 
fanout (greater than 24) and need to meet a maximum propagation delay. 

buf_duplicate: The logic gate that produced the source signal is duplicated 
multiple times. This "paralleling" of signal sources does not create additional 
levels of logic but does increase the load at the source inputs. For fanout loads of 
less than 24, duplicate buffering will usually yield better performance than 
normal buffering. The source logic must fit into a pASIC primitive P AfragA, 
P AfragF, logico or the like. This method increases the load at the source inputs. 

buf_register: Similar to duplicate buffering, registers are duplicated in 
parallel. This method does not create additional logic levels and works best for 
synchronous designs. For registered Signals, this method usually yields better 
performance than normal buffering. This method increases the load at the register 
input. 

Example: 

library ieee; 
use ieee.std_logic_1164.all; 

entity ld_reg is porte 
d: in std_logic_vector (31 downto 0); 
address: in std_logic_vector (3 downto 0); 
q: inout std_logic_vector (31 downto 0); 
clk: in std_logic); , 

end ld_reg; 

architecture arch_ld_reg of ld_reg is 
signal reg_en: std_logic; 
attribute buffer_gen of reg_en: signal is buf_normal; 
attribute max_load of reg_en: signal is 8; 
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begin 
main: process(clk) 

begin 
if (clk'event and clk = '1') then 

if (reg_en = '1') then 
q <= d; 

else 
q <= q; 

end if; 
end if; 

end process; 

reg_en <= '1' when (address = "1001") else '0'; 

Synthesis 

Without buffering of any kind (automatic buffer generation disabled), the 
reg_en signal has a fanout of 32. When importing into SpDE, the tool will warn 
that the reg_en signal has a high fanout. SpDE's path analyzer reveals that the 
worst case delay for a CY7C384A-2JC is 33.5 ns (-30 Mhz). To improve the 
performance, the VHDL file may be recompiled with buffer generation enabled in 
the device window of Galaxy (default), and max_load directive placed on the 
reg_en signal. With the max_load set to 8, the worst case delay is brought 
down to 18.2 ns (-55 Mhz). As a guideline, max_load should generally be set in 
the range of 5 to 13. Above 13 loads, the delay of a signal is mostly due to the 
number of loads and their associative routing. Between 5 and 13 loads, the tPD of 
the added buffer with its associating routing may begin to balance out the fanout 
delay. Below 5 loads, the buffering delay begins to outweigh the savings from 
load reduction. For example, when max_load is set to 4, the worst case delay is 
19.1 ns (52 Mhz), worse than when max_load is 8. It should be remembered that 
delays in an FPGA are design-dependent and place-and-route dependent. This 
means that for the same max_load setting, different designs and place-and
route iterations will have different performances, hence the recommended range 
of 5 to 13 loads. 

If the reg_en signal is a register~d signal, as in the code below, then the 
buf_register setting should be used with the buffer_gen directive. In 
register buffering (maX_load = 8), the register source is repeated. In this case, 
the register is automatically repeated four times to bring the worst case delay 
down to 15.6 ns (~64 Mhz). 
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9.6.2.2 
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architecture arch_ld_reg of ld_reg is 
signal reg_en: std_logic; 
attribute buffer_gen of reg_en: signal is buf_register; 
attribute max_load of reg_en: signal is 8; 

begin 
main: process(clk) 

begin 
if (clklevent and clk = Ill) then 

if (address = "1001") then 
reg_en <= Ill; 

else 
reg_en <= 10 1; 

end if; 

if (reg_en = Ill) then 
q <= d; 

else 
q <= q; 

end if; 
end if; 

end process; 

The PAD_GEN Directive 

attribute pad_gen or sigual_name: signal ZS value; 

The pASIC380 family has three different types of pins. Bidirectional pins may be 
configured as bidirectionals, inputs only, and three statable outputs. There are 
also dedicated inputs and clock input pins. The dedicated inputs are high drive 
inputs for use with signals with high internal fanout. Clock inputs utilize an 
internal clock distribution tree to achieve low skew. (Clock inputs can also double 
as high drive inputs.) The type of input can be specified by using the pad_gen 
directive. 

entity counter is port ( 
clock: in std_logic; 

) ; 
attribute pad_gen of clock: signal is pad_clock; 

end entity counter; 
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Synthesis 

Automatic: Warp defaults to this setting. This setting attempts to find the type of 
pad that best suits the implementation of the signal (bidirectional I/O, clock, or 
highdrive). This setting is activated when the automatic pad generation is enabled 
in the device window of Galaxy, and thepad_gen directive is set to pad_auto 
or no directive for pad_gen exists. 

Bidirectional I/O: The majority of input signals and all output signals use a 
bidirectional I/O pin. These pins can be configured as always active outputs, 
three-state outputs, inputs, and bidirectionals. To indicate to Warp that a signal 
should utilize an I/O pin, the above directive may be used with the value set to 
pad_none or pad_io. 

Dedicated High-Drive Input: When an input signal drives many internal logic 
gates (on the order of 8 or more loads), a dedicated high drive input can be used 
to reduce propagation delays. The high drive inputs have double the drive 
capability of a regular I/O input driver. Because they are intended for multiple 
loads in mind, high drive inputs require the use of express wires for routing. 
Express wires are routing resources that traverse the entire length of the device. 
For very large fanout counts, multiple high drive input drivers may have their 
outputs tied together. This requires that the input signal at the pins is the same. 
To have Warp utilize the dedicated inputs, use the above directive with the value 
set to: pad_hdl, pad_hd2, pad_hd3, or pad_hd4. 

Clock Input: To maintain a chip-wide skew of less than one nanosecond, the 
clock distribution tree limits clock input signals to being wired to the reset, preset 
and clock inputs of each logic cell's register. To utilize the clock inputs, use the 
above directive with the value set to pad_clock. 

The FIXED_FF directive 

ATTRIBUTE fixed_ff OF signal_name: signal IS 
register_location; 

Hand placement of logic cells within the device is generally not recommended, 
since an unrestricted place and route tool will be able to move logic cells near 
each other when necessary during placement to reduce delays and routing 
utilization. For cases where the user needs strict control over logic cell placement, 
however, hand placement of logic cells is possible using the directive f ixed_f f 
on the registered signal. The signal being fixed must be a signal on the Q output 
of a flip-flop or logic cell. The two most common situations which potentially 
benefit from assigning logic cell placement are discussed below. 
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Logic cell placement in a column arrangement is useful when used in conjunction 
with high drive inputs (dedicated inputs which can drive larger loads than the 
standard I/O). High drive inputs require the use of vertical routing lines that 
span the entire height of the device for small devices (express wires) or four logic 
cells for larger devices (quad wires). Because of this, arranging logic cells in a 
single column will require the use of only one express wire or a minimum 
number of quad wires, thus saving resources as well as decreasing the 
propagation delay. Fifo and shift register applications often will have this type of 
situation; however, it is recommended that this be the last step in optimizing a 
design for performance. 

Logic cell placement can also aid in minimizing register to pin delays. The Warp 
development system usually attempts to place the source logic cell near the 
output pin. To insure that critical output pin signals have minimal clock to valid 
times, however, the f ixed_f f directive may be used to lock the logic cell near 
the output pin. 

An example, counter4. vhd, is shown below (a 4-bit counter with enable). It is 
desired that the registers for the vector data be placed in a column. Since VHDL 
does not allow directives to be placed on individual signals of a vector, Warp's 
control file is used. 

library ieee; 
use ieee.std_logic_1164.all; 
use work.std_arith.all; 

entity counter4 is porte 
data: inout std_logic_vector (3 downto 0); 
clk,rst: in std_logic ); 

end counter4; 

architecture arch_counter4 of counter4 is 
begin 
process (clk,rst) 

begin 
if (rst=11 1) then 

data <= (others => 10 1); 
elsif (clklevent and clk=11') then 

data <= data + 1; 
end if; 

end process; 

end arch_counter4; 
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After compilation, it is noted that the data signal vector has been broken down 
into individual signals with labels da ta_ 0, da ta_l, etc. A control file is made 
by creating a new file called counter4.ctl. This file contains the code: 

attribute fixed - ff of data - 0: signal is "Bl"; 
attribute fixed - ff of data - 1: signal is "B2" ; 
attribute fixed_ ff of data - 2: signal is "B3" ; 
attribute fixed_ ff of data - 3: signal is "B'" ; 
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This results in the layout shown below: 

B 

'.1_.1 

Figure 9-4 Layout with fixed_ff directive 
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9.6.2.4 The STATE_ENCODING Directive 

9.7 

9.7.1 

9.7.2 

ATTRIBUTE state_encoding OF type_name: type IS value; 

Next-state equations for state machines with sequential encoding can be complex 
and product-term intensive. This is particularly undesirable in FPGAs because 
several cascaded logic cells may be required to complete the equations. A 
different state encoding scheme can reduce the complexity of the state encoding 
equations, thus reducing logic cell utilization and ultimately reducing state 
decode propagation delays. Two state encoding schemes which accomplish this 
are one-hot-one and one-hot-zero state encoding. 

See Section 9.4.2.1, "The STATE_ENCODING Directive," for more information. 

Documentation Directives 

The PART_NAME Directive 

A user may want to specify a particular device so that the original design 
documents specify which device it was designed for. This directive will override 
any target device command line switch or a Galaxy dialog box setting. 

entity counter is port 
a,b: in std_logic; 

) ; 

attribute part_name of counter: entity is "c371"; 
end entity counter; 

The ORDER_CODE Directive 

ATTRIBUTE order_code OF entity_name: entity IS "order_code"; 

A particular package and speed bin of a device can be specified to the Warp 
synthesis tool by using the directive order_code within the design to ensure 
timing information reflects the speed grade of the desired part. The order codes 
can be found in the Ordering Code column of the ordering information table for 
each device in the Cypress Semiconductor Programmable Logic Data Book. Timing 
delays for CPLDs are calculated according to the speed bin specified by this 
directive, or if no directive is specified in the VHDL code, the compiler will use 
the directive specified in the device window of Galaxy. 
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9.7.3 

entity counter is port 
a,b: in std_logic; 

) ; 
attribute order_code of counter: entity is "CY7C371-
66JC"; 
end entity counter; 

The PIN_NUMBERS Directive 

ATTRZBUTE pin_numbers OF entity_name: entity ZS "strinv'; 

Once a design has been completed and the board is defined, it may be desirable to 
maintain the pin out configuration when modifications to the programmable 
logic design are made. Locking signals to a particular pin can be accomplished by 
using the pin_numbers directive in the design. 

entity counter is port 
a,b: in std_logic; 

) ; 
attribute pin_numbers of counter: entity is "a:6 b:7 "; 

end entity counter; 

It is recommended that whenever possible, particularly the first time a design is 
fitted to a device, the pins of a device should not be locked. When the pins are not 
locked, the fitting tools can choose the optimal fitting arrangement within the 
device for performance as well as minimal resource utilization. In some rare 
occasions, certain pin arrangements can render a fitting impossible. 

Once a design has been fitted to a device (and the tool has already chosen a 
working pin configuration), the pin assignments can be back-annotated to the 
design schematic. The pin_numbers directive can also be used to set the pins of 
the design. 

9.8 Directive Format Summary 

364 

A summary of the VHDL attribute formats, possible values, and command line 
switches are provided in Table 9-12. 
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Table 9-12 Directive formats 

Directive VHDLFormat Values (D=Default) 
Cmd 
line 

goal attribute goal of arch_name: speed (D), area, or ygs 
architecture is value; combinatorial yga 

ygc 

state_encoding attribute state_encoding of sequential (D), 
type_name: type is value; one_hoCzero, --

one_hot_one, or gray 

buffer_gen attribute buffer_gen of buCauto (D), 
signaCname : signal is value; buCnone, buCnormal, 

yb 
buCduplicate, or 
buCregister 

max_load attribute max_load of 13 (D) or positive inte-
signaCname : signal is integer; ger 

ym 

pad_gen attribute pad_gen of pad_auto (D), 
signaCname : signal is value; pad_none, pad_clock, 

pad_hd1, pad_hd2, yp 

pad_hd3, pad_hd4, or 
pad_io 

synthesis_off attribute synthesis_off of false (D) or true --signaCname : signal is value; 

dont_touch attribute dont_touch of false (D) or true 
labeCname : label is value; --attribute dont_touch of 
entity_name: entity is value; 

no_latch attribute no_latch of false (D) or true 
yl 

signaCname : signal is value; 

lab_force attribute lab_force of Example: "A1" --signaCname : signal is location; 

pin_avoid attribute pin_avoid of Example: "1 2 3" --entity_name: entity is location; 
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Directive VHDLFormat Values (D==Default) 
Cmd 
line 

polarity attribute polarity of pLdefault (D), pLkeep, fk 
signaCname : signal is value; orpLopt fp 

sum_split attribute sum_split of balanced (D) or cas- --signaCname : signal is value; caded 

node_num attribute node_num of nd_auto (D) or positive 
fn 

signaCname : signal is value; integer 

fixed_ff attribute fixed_ff of Example: II A2" 
fn 

signaCname : signal is location; 

ff_type attribute ff_type of fLdefault (D), ff_d, ff_t, fd 
signaCname : signal is value; or fLopt ft 

fo 

no_factor attribute no_factor of false (D) or true 
f1 

signaCname : signal is value; 

opt_level attribute opt_level of 2 (D), 1, or 0 
0 

signaCname : signal is integer; 

part_Dame attribute part_name of Example: "c371" 
d 

entity_name: entity is string; 

order_code attribute order_code of Example: "PALC22VI0-
entity_name: entity is string; 25HC" 

p 

piD_Dumbers attribute pin_numbers of Example: "sigl:l " & 
ff 

entity_name: entity is string; "sig2:2" 
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Once a design has been compiled, synthesized, and simulated, it is ready to be 
implemented in silicon. This implementation consists of two steps: the generation 
of a programming file and the programming of the device. In this section, both 
steps will be discussed for all devices in the Cypress programmable logic family. 

The programming file type that the designer generates depends upon the device 
type to be programmed. Three programming file types exist for Cypress devices, 
JEDEC 'jed), POF 'po!), and LOF pof>. The table below summarizes the file type 
needed for each of the Cypress device types as well as the steps required to 
generate these files. These steps are described in detail in this section. 

Table 10-1 Programming file types 

Device Type 
Programming File 

How to Generate File 
Type 

Run Galaxy 
Small PLDs, FLASH370 

JEDEC 
Go to Device menu 

CPLDs Output: JEDEC Normal 
Compile Design 

Run Galaxy 
Go to Device menu 

MAX340 CPLDs POF Output: JEDEC Normal 
Compile Design 
Run jed2pof.exe from DOS 

Run Galaxy 
Go to Device menu 
Output: QDIF 

pASIC380 FPGAs LOF 
Compile Design 
RunSpDE 
ImportQDIF 
Run place and route 
Export LDF 

Generating a JEDEC File 

For programming a small PLD or a FLASH370 CPLD, a JEDEC file is required. In 
the Warp design environment, this file is created as the last step of compiling a 
design. JEDEC file generation is enabled in Galaxy by clicking on the Device 
button in the main project window, and then selecting JEDEC Normal as the 
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Output option. This programming file will have the same base name as the top
level design file with a .jed extension. 

Two output file formats are possible when a small PLD or CPLD is selected, 
JEDEC Normal and JEDEC Hex. Both files contain the same information but 
slightly differ in format. Whereas the JEDEC Normal represents fuse addresses 
and data in binary (0 and 1), the JEDEC Hex represents them in hexadecimal 
(0 through F). Most device programmers require the JEDEC Normal format, and 
the programmer software will generate errors if the JEDEC Hex file format is 
used. 

Some portions of a JEDEC file are included below to provide an example of the 
information that it contains: 

Cypress c371 Jedec Fuse File: test.jed 

This file was created on 12/11/95 at 10:20:55 
by C37XFXT.EXE 06/MAR/95 [v3.17B] 3.5 XR x96 

ABc371* 
QP44* 
QF13274* 
FO* 
GO* 
NOTE DEVXCE c371* 

Number of Pins* 
Number of Fuses* 
Note: Default fuse setting 0* 
Note: Security bit Unprogr~ed* 

NOTE PACKAGE CY7C371-143JC* 
NOTE PXNS aeqb:2 b_3:10 b_2:11 
NOTE PXNS a_0:42 a_1:43 * 
NOTE NODES * 
NOTE NODES * 
LOOOOOO 
000000000010000000000011100000000000000000100000000000000011 
100000000000 
* Note: LAB 1 BANK OE 0* 

L000072 
000000010000000011111000000000000000100000000000001000100000 
010000000000 
* Note: LAB 1 BANK OE 1* 
(etc.) 
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CC3B5* Note: Fuse Checksum* 

QV4l5l* Note: NUmber of Test Vectors* 
VOOOl NLllBFZZ010NC10Zl0ZZZNNZZZLllZlllNOZLLLHHZLN* 
V0002 NLllBLZZ010NC10Zl0ZZZNNZZZLllZlllNOZLLLHHZLN* 
V0003 NLllBLZZOOONC10Zl0ZZZNNZZZLllZlllNOZLLLBRZLN* 
(etc.) 

V4l5l NLllFF10Z00NCZZZZZZZZNNZZZLZZZ001N1ZLLHLHZBN* 
"'CI'FAO Note: File Checksum* 

At the top of the file is information about the design compilation, including the 
software revision number, date of compilation, and filename. Further down in the 
file is the design and device information. The QP field (QP44) tells the user that 
this file is for a 44-pin device. The QF field denotes the total number of fuses that 
can be programmed: 13,274 for a CY7C371. A few lines below this are several 
NOTE fields detailing the device, package, and signal names for the design 
signals. The device programmer does not use these fields, but simulators use 
them for package-specific pin numbers and signal names during simulation. 
Because the programming algorithm does not use this pin information, but rather 
only uses the fuse numbers for addressing internal locations within the device, 
the user can program any package of a given device type with the same JEDEC 
for that device. For example, the designer could use a TQFP package to compile 
and simulate a design, and then use the resulting JEDEC file to program a PLCC 
package of the same device. In short, the package information in the file is 
relevant not for programming but for simulation. 

Mter the NOTE fields, the fuse address and data begins. Each L field in the 
JEDEC file corresponds to a region of the device. The data following the L field 
corresponds to the values to be programmed in those locations (1 = programmed, 
0= unprogrammed). 

Near the end of the file are two checksums, a fuse checksum and a file checksum. 
First, the fuse checksum represents the sum of all of the fuse values in the JEDEC 
file. Device programmers often use this sum to verify that the pattern 
programmed into the device (number of fuses programmed) matches the number 
in the JEDEC file. By reading the fuse values from a programmed device, the 
programmer determines the number of fuses that were programmed. In the 
sample JEDEC file above, the fuse checksum is C3B5. The checksum value is 
always preceded by a C. 
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The file checksum, which is the last line in the file, represents a total value for all 
characters in the JEDEC file, including both fuse values and notes, comments, and 
signal names. Using this checksum value, the designer can tell if the 
programming file has been corrupted or modified. If the file has been changed, 
the file checksum computed by the device programmer will not match the 
checksum in the file, and an error will be reported. In the sample JEDEC file, the 
file checksum is FFAO, preceded by I\C. 

Between the fuse checksum and the file checksum are test vectors for the design. 
Device programmers use these vectors to test the functionality of the 
programmed device. Using these vectors in sequence, the programmer applies 
inputs to the device and checks the outputs for the expected values. The QV field, 
found immediately after the fuse checksum, represents the number of test vectors. 
This sample design has 4,151 test vectors. Many third-party software companies 
offer products that automatically generate test vectors for a design using a JEDEC 
file as the input. 

10.2 Generating POF Files for MAX340 CPLDs 

The steps required to program the MAX340 CPLDs are identical to those 
discussed above for FLASH370 CPLDs with one additional step required to 
produce the programming file. After the design is compiled and produces a 
JEDEC Normal file, that file must be converted to a POF 'pof) file. POF files are 
binary programming files which are not based on the JEDEC standard. 
Programming algOrithms developed for the MAX340 CPLDs use this format 
instead of the JEDEC format. 

To perform the conversion from JEDEC to POF, the executable jed2pofexe must be 
run from DOS. This program takes the device type and JEDEC filename as input 
and produces a file with the same base name and a .pof extension. The part can 
then be programmed on a device programmer. If you are using the Warp 
software on a PC, this utility can be found in the c:\warp\bin\jed2poJ directory. 
If you are using a workstation, you can obtain this program from the Cypress 
Bulletin Board System (BBS) at (408) 943-2954. 
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10.3 Generating LOF Files for pASIC380 FPGAs 

Cypress pASIC380 FPGAs require a different programming file format, the LOF 
~loj) format. After performing place and route on a design using SpDE, the 
designer can generate a LOF file by going to the File menu in SpDE and selecting 
Export LOF. The fuse information is then stored in the LOF file (design.lof). If 
running SpDE on a PC platform, the user then has the option of zipping the LOF 
file after it has been generated. Doing so significantly reduces the size of the file 
(which can be several megabytes) and produces the format required by the Data 
I/O Unisite programmer. The Cypress Impulse3 programmer uses the unzipped 
version of the LOF file instead of the zipped version. If the file has been zipped, 
the user would unzip it using pkunzip.exe, a popular shareware utility available 
on the Cypress BBS. 

At the top of any LOF file are several fields containing information about the 
device type, programming file, and the software revision of the SpDE software 
used to generate the file. Some portions of the LOF file header are included below: 

Design name: test 
Part name: p16x24b* 
QP144* 
(etc.) 

QRS.06* 
(etc.) 

In the example above, the QP field represents the number of pins on the device -
144 in this case. The QR field gives the revision number of the SpDE place and 
route software used to generate the LOF file. 

10.4 Device Programmers 

372 

Cypress sells a programmer called the Impulse3 that supports PROMs, small 
PLDs, CPLDs, and FPGAs. Different part and package combinations require 
various programming adapters that fit onto the base unit of the programmer. By 
using the correct programming adapter and generating the programming file as 
discussed earlier in this section, all of the Cypress devices can be programmed 
using Impulse3. Software updates for Impulse3 are free and are available on the 
Cypress World Wide Web home page. 
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Other third-party vendors such as Data I/O, BP Microsystems, SMS, System 
General, and Logical Devices offer varying degrees of programming support for 
Cypress devices. The Data I/O Unisite has the most complete support for Cypress 
devices of these third-party programmers. The designer should directly contact 
the manufacturer of these third-party programmers for device support questions. 
The design flow for programming each type of device is summarized in the 
following graph. 

GALAXY 

"Device" button 
Output: JEDEC Normal 

"Device" button 
Output: QDF 

Small PLDs 
FLASH370 

MAX340 pASIC380 

JEDEC 
(.jed) 

JEDEC 
(.jed) 

jed2pof.exe 
(from DOS) 

POF 
'pof) 

QDIF 
(.qdf) 

SpDE 
Place and 
Route 

File->Export LOF 

LOF 
(.Iof) 

DEVICE PROGRAMMER 

Figure 10-1 Design flow for device programming 
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